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Introduction

MS-DOS in Brief

MS-DOS is short for Microsoft® Disk Operating System. An
operating system is an integral part of the computer without
which the computer does not work.
The operating system is actually a set of commands and
programs that control the use of the computer. In this way, the
operating system acts as an interpreter between you and your
computer. It provides such system services as diskette reads and
writes, and file management.

Apart from the operating system, the MS-DOS diskettes contain
useful utilities and other additional programs. The MS-DOS
diskettes are delivered to you in accordance with the terms and
conditions of the Nokia Licence Agreement. A copy of the
Agreement accompanies the diskettes. Read the Agreement
carefully. It is a legal document between you and Nokia Data.
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Introduction

This Manual

The User’s Guide has two main functions. First of all, it tells
you how to install MS-DOS. Secondly, it shows you the most
important features of MS-DOS. If you are new at working with
operating systems for personal computers, you need to learn
them before going on to the more advanced features. This guide
was written to serve that particular purpose. This is why we
highly recommend that you read it from cover to cover.
Every Chapter begins with a short summary. If you read the
summaries first, you can form a good idea of what MS-DOS is
all about.

Note This manual is not an introduction to computer
science. If  you have no previous experience, you
may have to consult computer literature, or
enroll in courses for more general information.
For example, make a list of any computer-literate
colleagues who can help you, especially in the
beginning.
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Introduction

Other MS-DOS Manuals

After reading this manual, or for an experienced personal com-
puter user, we recommend the following manuals:

MS-DOS® Shell User’s Guide

This guide focuses on MS-DOS Shell. It is intended for both
beginners and experienced users. It contains exercises,
instructions and reference-type material.

MS-DOS® User’s Reference Manual

This manual provides a systematic and comprehensive account
of the features that cannot be fully treated in the User’s Guide.
These include a complete list of MS-DOS commands, and a
detailed description of EDLIN.

The User’s Reference Manual is tougher reading than the
User’s Guide. It would not be practical to read it from cover to
cover, you gradually learn when to consult this manual.

MS-DOS® Programmer’s Reference
Manual

This manual is intended for application program developers. It
covers advanced technical subjects, such as DOS system calls
and device drivers. If you use only application programs (e.g.
spreadsheet programs, or word processing programs) you do
not need this manual.
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Introduction

Notational Conventions

Throughout this manual, the following conventions are used to
distinguish elements of text:

bold Boldface indicates commands, options, switches,
or anything that you should type exactly as
shown. For example, in the following command

C:\USERS>dir *.♦ <ENTER>

the portion you must type is “dir

<KEY > Angle brackets hold the name of the key you
should press. The name of the key appears in
uppercase letters. In the example command
above, you should press <ENTER>.

<KEY -KEY> Angle brackets holding two or more key names
separated with a dash tell you to press the keys
simultaneously, for example
<CTRL-ALT-DEL>.

Display text examples

This layout illustrates the messages displayed on
the screen.
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Introduction

\Ne Would Like to Hear From
You!

This manual is written for you. This is why your opinions and
suggestions are very important to us. We welcome comments
on both its contents and appearance, and we would appreciate it
very much if you take the time to write them down. Please send
your comments to:

Nokia Data
Technical Writing
P.O. Box 780
SF-00101 Helsinki, Finland

Welcome to the world of MS-DOS!
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Installation

Summary

This Chapter describes how to install MS-DOS on the fixed
disk or diskettes. If your computer has a fixed disk, the most
practical solution is to install MS-DOS there.

To install MS-DOS, you must run the SELECT program which
takes you step by step through the entire process.

When running SELECT, you can choose whether you want
to install the Shell, too. The Shell is the graphic extension of
MS-DOS that lets you take advantage of the power of MS-DOS
with a few keystrokes or a click of a mouse. The Shell is
described in its own manual, the MS-DOS® Shell User’s Guide.

You may already have an operating system on the fixed disk. In
this case, you can start working directly, or run the SELECT
program to change the default settings. However, unless you are
familiar with configuring operating systems, the fastest way you
can start working is to use the system already installed on the
fixed disk.
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Installation

What You Need to Check First

Before you run the SELECT program, do the following things
to speed up the installation process.

If you are going to replace an older version of MS-DOS
with this version (4.0), back up all your old files now!

Information on Your System

Check out the following information about your system:

• the amount of memory available

• the type of printers (if you have any) - serial or parallel

• the amount of expanded memory (if any)

Having these facts ready allows you to respond more quickly
to the questions the SELECT program will ask you during the
installation process.
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Installation

Diskettes for the Installation

Regardless of whether you are going to install MS-DOS on
the fixed disk or diskettes, you will need unformatted diskettes
during the installation.

Check the type (size and capacity) and number of the original
MS-DOS diskettes delivered to you. Have the same number of
unformatted diskettes of the same type at hand.

The number of the diskettes you may actually need will vary:
you may not need all the unformatted diskettes. On the other
hand, you will never need more than the number of the original
diskettes.

Note If you are going to install MS-DOS with the
Shell, have one more diskette for it at hand.

Diskettes are discussed in more detail in the Chapter on
diskettes later in this guide.

1-5



Installation

The SELECT Program

The SELECT program is a series of screens that take you step
by step through the installation of MS-DOS.

SELECT contains eight screens. The first two screens,
Welcome and Introduction, help you check that you have
enough diskettes for the installation, and tell you how the keys
work. The remaining six screens help you through the actual
installation.

Each screen proposes selections that you can use for your
system. Unless you have a special reason, the easiest and fastest
way of installing MS-DOS is to accept the default values.

If you need further information on an item on a screen,
press <F1>.

Running the SELECT Program

To start the SELECT program, follow these steps:

|~1~| Make sure the power is turned off from your monitor
and computer, and insert the MS-DOS Install diskette
in drive A.

[~2~| Turn on the power for your monitor and your computer.
The Welcome screen appears.

|~3~| Press <ENTER>. The Introduction screen appears. This
screen tells you about the function keys that you can use
to run the SELECT program. Study the keys carefully.

[~4~| Press <ENTER>. The first actual installation screen,
Function and Workspace, appears.
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Installation

Screen 1 : Function and Workspace

Here you can allocate memory between MS-DOS (Function)
and your application programs (Workspace).

Unless you have a special reason, accept the default selection.

If you are an experienced computer user, and you do not want
the default selection, base your allocation on the amount of
memory available in your system and the memory requirements
of any application program you may run.

Option 1 Choose option 1 when the amount of memory is
critical for running application programs (e.g. in
256-kilobyte-systems). This choice allocates a
minimum amount of memory to MS-DOS and a
maximum amount to your applications.

Option 2 If your system has 512 kilobytes, choose this
option. This allocates equal memory for
MS-DOS and your applications.

Option 3 This is the default selection (i.e. over
5 12-kilobyte-systems). This allocates the
maximum amount of memory to MS-DOS, yet
leaves ample memory for your application
programs.

Screen 2: Country and Keyboard

Now you can choose the “nationality” of your computer. Select
your own nationality so that you can work with a familiar key-
board layout (characters are located where you are used to
finding them), decimal separator, monetary symbol, and date
and time format.

The available options are listed in the menus. If you choose
Denmark, Portugal, Norway, or French-speaking Canada, you
must use the screen 6 (Installation Options) to set the Code-
Page Switching option to Y(es).
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Installation

Screen 3: Selecting the Installation Drive

Now you can choose whether to install MS-DOS on the fixed
disk (drive C), or on diskettes (drive A or B).

If your computer has a fixed disk, choose drive C. The Specify
MS-DOS Location screen appears, and proposes a location for
MS-DOS. Unless you want another location, accept the default.
If you want another location, use the options on this screen to
specify a new directory or path.

If you are running SELECT with an older MS-DOS version,
copy its non-system files to a different directory.

Screen 4: Number of Printers

This screen lets you specify a printer model from a list of
printers and choose an appropriate port. Though you can
specify up to seven printers, one is usually quite enough.

Printers are either parallel or serial printers, according to their
connection. The system unit is equipped with parallel and serial
connectors called ports. Specify a printer according to the type
of your equipment.

If an application programs requires a parallel port for printing,
you can use this option to name a serial printer with a parallel
port name. However, if a parallel printer has already been
assigned to that name, do not name a serial printer with it.

Screen 5: Installing MS-DOS Shell

Here you can install the Shell, the graphic extension of MS-
DOS. The Shell lets you start programs and work with your
files with a few keystrokes or a click on a mouse. The Shell also
gives you quick and easy access to many basic MS-DOS utili-
ties. In addition, you can customize the Shell for installing your
application programs.

For more information on MS-DOS Shell, study the MS-DOS®
Shell User’s Guide.
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Installation

Screen 6: Installation Options

Unless you made changes, tell SELECT to skip the review.
According to whether you are installing MS-DOS on a fixed
disk or diskettes, read the first or the second of the following
two sections.

The selections you have made on the earlier screens affect
the AUTOEXEC.BAT and CONFIG.SYS files which, in turn,
affect the way your system works. Before completing the
installation, you can now review and change the selections.

If you choose to review and change the selections, a series of
parameter menus appears. The help information for these
menus contains examples of valid parameters and memory
ranges, as well as guidelines for making the choices that are
correct for your system.

Installing MS-DOS to a Fixed Disk

If the fixed disk is not partitioned, let SELECT partition and
format it for you. After this, SELECT asks you for permission
to complete the installation by copying the MS-DOS system
files to the fixed disk. When SELECT has installed MS-DOS, it
tells you how to start MS-DOS.

If you are running SELECT with an older MS-DOS version,
SELECT has placed your selections into files named AUTO-
EXEC.400 and CONFIG.400. Before booting, compare them
with your previous AUTOEXEC.BAT and CONFIG.SYS, and
make any necessary changes. After updating the files, restart
your system by pressing the <CTRL-ALT-DEL>.
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Installation

Installing MS-DOS to Diskettes

Now SELECT helps you to install MS-DOS on the diskette(s).

When the installation is complete, you have the diskettes that
you need when working with MS-DOS.

The SELECT gives names to the diskettes. The diskette labeled
“STARTUP” can start MS-DOS.
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Installation

Backing Up MS-DOS

A vital measure not to be ignored or neglected is making a
backup copy of your MS-DOS diskettes. Back up your MS-
DOS diskette(s) using the DISKCOPY command described
later in this manual.

Instead of the original MS-DOS diskettes,
back up the working diskette(s) that you
created during the installation process.
Store the diskette(s) in a safe place.
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Start-Up

Summary

When you turn the power on, the computer runs a program
called the self test to check that the hardware is in working
order. After the self test, the computer looks for the files of the
operating system, first in drive A, and then in drive C. When
they are found, the computer loads the operating system into
memory and starts it. In the jargon of the field, this operation is
called “booting”.

Date and time are important, because they indicate when a file
or directory was created or last changed. This Chapter shows
how you can check the calendar and clock of the system by
using the DATE and TIME commands.

Sometimes, during a working session, you may have to restart,
or “reboot” MS-DOS. Instructions for restarting and ending a
working session are at the end of this Chapter.
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Start-Up

Starting MS-DOS

When you turn the power on, the computer runs a program
known as the self test that resides in the computer’s ROM
memory. The self test checks the hardware before the operating
system is loaded into memory.

If the self test does not find any errors, the computer is in
working order. Now the computer begins searching for the
operating system, first in the diskette drive A, and then in drive
C of the fixed disk. When the required files are found, the
computer loads the operating system into memory and starts it.

Starting MS-DOS from the Fixed Disk

If you have installed MS-DOS on the fixed disk, make sure that
the diskette drive A is empty, and start the computer. After the
self test, the computer loads MS-DOS into memory and starts it
from the fixed disk.

Starting MS-DOS from a Diskette

To start MS-DOS from a diskette, insert a diskette containing
the MS-DOS files in drive A, and start the computer. After the
self test, the computer loads MS-DOS into memory and starts it
from this diskette.

If you have inserted a diskette that does not contain MS-DOS,
the following message will be displayed:

Non-system disk or disk error
Replace and strike any key when ready

Replace the diskette with a diskette that contains MS-DOS, and
press any key. The computer loads MS-DOS into memory and
starts it from this diskette.
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Start-Up

Prompt and Cursor

The prompt is a symbol MS-DOS displays when it is ready to
receive commands. While MS-DOS is executing a command,
the prompt disappears.

The prompt consists of a letter, a colon, and the greater-than
sign, for example

A:\>_ or C:\>_

The letter identifies your default drive. Between the drive letter
and the greater-than sign you usually see also the name of your
current directory. A backslash ( \ )  indicates that you are in the
root directory of the current drive. Drives and directories are
discussed later in this manual.

You can change the appearance of the prompt. This is described
in the MS-DOS® User’s Reference Manual. In this manual, the
forms shown above are used, for the sake of clarity and brevity.

Next to the prompt on the right you see a blinking box or
flashing underline, the cursor. With the cursor, MS-DOS tells
you your exact location on the screen and shows where the next
character you type from the keyboard will appear.
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Start-Up

Date and Time

The system has a clock and calendar which are important
because MS-DOS uses them to “stamp” each file and directory.
The “stamp” tells you when you created or last changed a file or
directory.

The following sections show how you can check the calendar
and clock by using the DATE and TIME commands. The
format in which the date and time are displayed depends on the
nationality that you chose when you installed MS-DOS.
For more information on the DATE and TIME commands, see
the MS-DOS® User ’s Reference Manual.

Checking the Date

You can check the system calendar with the DATE command.
At the prompt, type

C:\>date <ENTER>
MS-DOS displays a message similar to the following:

Current date is Mon 10-24-1988
Enter new date (mm-dd-yy)

If the date is correct, you can accept it by pressing <ENTER>.
If you want to change it, enter the new date in the order speci-
fied in the parentheses (in the example “mm-dd-yy” for month-
day-year), and press <ENTER>. Note that this change is tempo-
rary; MS-DOS cancels it when you turn the power off.

2-6



Start-Up

Checking the Time

You can check the system clock with the TIME command. At
the prompt, type:

C:\>time <ENTER>

MS-DOS displays a message similar to the following:

Current time is 13:35:00.00
Enter new time:_

If you accept the time, just press <ENTER>.

If you want to change it, type the time in the form it is
displayed, and press <ENTER>. You do not have to type
seconds and hundreths of seconds. Note that the change is
temporary; MS-DOS cancels it when you turn the power off.
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Start-Up

Restarting MS-DOS

Sometimes you may need to restart MS-DOS during a working
session. There are two ways for doing it:

♦ You do not necessarily have to switch the power off, just
press <CTRL-ALT-DEL>. The computer interrupts all
operations, and reloads and starts MS-DOS from the fi-
xed disk or diskette as described earlier in this Chapter.

• If the key sequence is not enough to restart MS-DOS,
you may have to turn the power first off and then on
again.

In the jargon of the field, restarting is called “rebooting”. The
jargon has two more “terms” for starting, according to whether
you use the key sequence, or turn the power on. In the jargon,
pressing <CTRL-ALT-DEL> is called “soft boot,” and turning
the power on is known as “hard boot”.
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Start-Up

Reading the READ. ME File

You may have a text file named READ.ME in the root directory
of the fixed disk drive C, or in the root directory of the diskette
labeled “Startup,”, depending on where you installed MS-DOS.

READ.ME is a text file which contains important information
that was not available when the current edition of the manuals
went to the printer. You should now check whether you have
this file, and if so, read it.

Choose the correct instruction section according to whether you
installed MS-DOS to the fixed disk or diskette(s).

Reading the File from the Fixed Disk

|T| To check whether the file exists, give the following
command:

C:\>dir read.me <ENTER>

If the file exists, MS-DOS displays its name, size and
creation time. If the file does not exist, MS-DOS
displays this message:

File not found

If the file exists, read it with the following command:

C:\>more cread.me <ENTER>

The MORE command displays the file one screenful at a
time. When you want to “turn the page,” press any key.

□
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Start-Up

Reading the File from a Diskette

□ Insert the diskette labeled “Startup” in drive A. At the
prompt, type:

A:\>dir read.me <ENTER>

If the file exists, MS-DOS displays its name, size and
creation time. If the file does not exist, MS-DOS
displays the following message:

File not found

|~2~] If the file exists, read it with the following command:

A:\>more <read.me <ENTER>

The MORE command displays the file one screenful at a
time. When you want to “turn the page,” press any key.

The DIR command is described in the Chapter titled Directories
later in this manual.

For more information on the DIR and MORE commands, see
the MS-DOS® User’s Reference Manual.

2-10



Start-Up

Ending a Working Session

End your MS-DOS session by following these steps:

[T| Make sure that that your last command is  finished. You
shoud see the MS-DOS prompt (C:\>, or A:\>) on the
screen.

[2] Remove diskette(s) from the diskette drive(s). Put the
diskettes back in their protective jackets, and store them
in a safe place.
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Commands

Summary

This Chapter describes the basics of using MS-DOS. First, you
learn to identify and specify drives, as the drive is the first thing
the computer must know about the location of a file or program.

The second issue is commands. With commands you tell the
computer what you want it to do. The computer expects you to
follow a particular “grammar” when giving commands. This is
called the syntax. Wildcards are characters that make entering
commands more flexible.

MS-DOS offers you several special functions that ease and
speed up your work. These include the MS-DOS editing keys
that make use of a special memory area, the template, to store
commands for you to use either as such or in an edited form.

For a beginner, most special functions will be useful after the
basics have been mastered. This is why this Chapter contains
only a brief introduction to e.g. redirection and filters, to give
you a hint of the capabilities of MS-DOS.
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Commands

Identifying Drives

The first thing that the computer must know about the location
of a file or a program is the specification of the drive where it
resides.

Drive Specification

In this manual, “drive” refers to a diskette drive or to one of the
partitions on a fixed disk, according to each situation.

MS-DOS gives each drive a specification. The drive specifica-
tion consists of the letter code of the drive and a colon ( : ), for
example:

A:  (diskette drive A)
C: (fixed disk drive C)

MS-DOS assigns the letters in alphabetical order from A and Z.
You cannot change these codes.

When you type the drive specification, you can use either upper-
case or lowercase letters. When the drive specification is includ-
ed in a file specification, it  must precede the name of the file.
Files are discussed below in the Chapter entitled Files.

For more information on the drive letters, consult the MS-
DOS® User’s Reference Manual.
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Commands

Drive Specifications of Diskette Drives

The letters A and B are always reserved for diskette drives,
even if your computer has only one.

Drive Specifications of Fixed Disk Drives

The letters from C to Z are given to fixed disk drives.

Drive Specification of RAM Disk

The RAM disk is  not a physical drive. It is a part of memory
which is used as if it were a drive.

When all fixed disk partitions have letters, the RAM disk gets
the first free letter. For example, if you have two partitions on
the fixed disk, they will be C and D, and the RAM disk would
beE .

Default Drive

When you give a command, MS-DOS searches first the default
drive for a file or program. So, if the desired file or program is
in the default drive, you do not need to include the drive specifi-
cation in the command.

You can check your default drive by looking at the prompt: the
letter in the prompt is the specification of the default drive.

If you have omitted the drive specification and the computer
cannot find the desired file in the default drive, MS-DOS
displays an error message. However, you can instruct the
computer to search several drives and/or directories automatic-
ally. This is  done by including the PATH command in a batch
file called AUTOEXEC.BAT. You will learn more about
PATH and AUTOEXEC.BAT later in this guide.
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Commands

Changing the Default Drive

You do not have to use the same default drive all the time. For
example, if you are working with files on a diskette in drive A,
it would be more practical to have drive A as the default drive.
Changing the default drive is very easy. You just enter the drive
specification as a command.

Example:

Your default drive is C and you want to change it to A. Use the
following command:

C:\>a: <ENTER>

The prompt changes to A:\>, and drive A is now your default
drive.

Note If you have an unformatted diskette in drive A
when you give the command to change drives,
MS-DOS displays an error message.
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Types of Command

MS-DOS commands are generally divided into three categories:

• internal commands

• external commands

• batch files

Internal Commands

Internal commands are the simplest and most commonly used
commands. They are a part of the command processor, stored in
the COMMAND.COM file. This is why you cannot see the
names of these commands when you display a directory listing
of MS-DOS.

When you start MS-DOS, the computer loads the internal
commands into memory. They remain there until you turn the
power off or restart MS-DOS. Thus MS-DOS can execute an
internal command immediately.

Below is a list of some internal commands that are discussed in
this guide. Parentheses are used for synonyms.

MD (MKDIR)
PATH
RD (RMDIR)
REN (RENAME)

CD (CHDIR)
COPY
DEL (ERASE)
DIR

The commands are described in detail in the MS-DOS® User’s
Reference Manual.
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External Commands

External commands are stored in their own files. This means
that the computer reads them into memory only when you enter
the corresponding command. After execution, the command is
removed from memory.

Any file ending with .COM or .EXE contains an external
command. For example, programs such as FORMAT.EXE and
MORE.COM are external commands.

When you use an external command, just enter the filename as
the command and omit the ending.

Below is a list of some external commands that are discussed in
this guide:

APPEND
BACKUP
CHKDSK

FORMAT
PARKHD
PRINT

DISKCOPY RESTORE

The commands are described in detail in the MS-DOS® User’s
Reference Manual.
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Batch Files

Often you may find yourself typing the same sequence of
commands over and over to perform a task you use frequently.
With MS-DOS, you can save time by putting these commands
into a special file: a batch file. When you want to execute the
command sequence, you do not have to enter the commands
separately - you just use the name of the batch file as a com-
mand. The computer processes a “batch” of commands in the
given order, as if you had typed them in one by one on the key-
board. This saves your time and speeds up your working.

Batch files must have an extension of .BAT. When you execute
a batch file, enter the filename as the command, and omit the
filename extension.

You can create a batch file for example with the EDLIN editor
of MS-DOS, with the COPY command, or with any word pro-
cessor that produces ASCII files. You can also include com-
ments in the file to help you remember what the batch file is
supposed to accomplish.

Writing batch files is  not difficult, but you must master some
basic skills first. This is why batch files are discussed in the
MS-DOS® User’s Reference Manual. Be careful, especially in
the beginning. Make sure that your batch files perform exactly
the tasks that you have in mind - nothing more and nothing less.

The AUTOEXEC.BAT File

The name AUTOEXEC.BAT is  reserved for a special purpose
batch file. Each time you start the computer, MS-DOS runs the
commands placed in AUTOEXEC.BAT.

You can make changes to AUTOEXEC.BAT, but be especially
careful. For more information on the AUTOEXEC.BAT file,
see the MS-DOS® User’s Reference Manual.
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Giving Commands

MS-DOS commands have their own “grammar”, the syntax,
that you must follow. Commands consist of standard parts
which have to be entered according to certain rules. All parts
cannot always be used in the same command. Moreover, some
parts are compulsory, some optional. The syntax of the com-
mand tells you what must be included.

Most commands begin with the name of the command, a word
or an abbreviation such as FORMAT or MD. After this, you
must provide the information needed for the execution of the
command in the form of command parameters. They tell exact-
ly what and how you want MS-DOS to do to a file or program.

Command Parameters

Some commands often take parameters which can be file speci-
fications, switches, or arguments. Parameters are optional and
make commands more flexible, as they allow you to execute a
command in different ways.

File Specifications

File specifications specify the files on which the command
should be executed. A complete file specification consists of a
drive specification, path, filename, and filename extension.
However, a complete file specification is not always required.
For example, in the DISKCOPY command the file specification
consists of only a drive specification.

You will leam more about files and file specifications in the
Chapter entitled Files.
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Switches

Switches are single-character codes preceded by a slash ( / ).
For example, when formatting a diskette you can also give it a
name (a volume label) if you include the /V switch in the
command.

Arguments

Arguments also provide the computer with additional infor-
mation on how to execute a command. Usually, you choose
between arguments, for example ON or OFF.

General Rules on Using Commands

The following rules apply to all MS-DOS commands. Study the
list carefully, for the information it provides will be very useful
when you work through the following sections and Chapters.

• T ype all MS-DOS commands at the prompt. If you do
not see the prompt on the screen, the computer is still
executing the previous command.

• You can type commands in uppercase or lowercase (or
in any combination). MS-DOS translates all into upper-
case.

• If  you make a typing error, you can move back to correct
it  by pressing <BACKSPACE>.

• As described above, commands consist of parts, some of
which may be optional. The usual parts are the command
name, one or more file specifications, and one or more
switches and arguments.
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• The parts of a command are separated from each other
with a delimiter. MS-DOS accepts the following
delimiters: space ( ), comma ( , ), semicolon ( ; ), equal
sign ( = ), and the tab key.

In this guide, one blank space ( ) is used as the delimiter
in commands.

• Do not use the above delimiters within file specifica-
tions. In a file specification, the period ( . ) and colon
( : ) have a special purpose.

• In file specifications, the names of directories are sepa-
rated with the backslash ( \ ) .

• You must include the filename extension when you are
referring to a file that has one. The only exception is the
name of a command file.

• The computer starts executing a command when you
press <ENTER>.

• You can abort commands when they are running by pres-
sing <CTRL-C>. Note that not all applications allow this
function.

• When you are instructed to “Press any key,” you can
press any of the character keys or the spacebar.

• If a command produces a large amount of output on
the screen, the display automatically scrolls to the end
without stopping. To interrupt the scrolling, press
<CTRL-S>. To continue, press any key.

• You can use the special characters called wildcards as
well as the MS-DOS editing and function keys when
entering commands. They are described in the following
sections.
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Wildcards

Two special characters called wildcards can be used in some
commands to make them effect more than one file at a time.
This gives you greater flexibility in using commands. These cha-
racters are the question mark ( ? )  and the asterisk ( * ).

Wildcards are powerful. Use them cautiously!

The Question Mark ( ? )

A question mark ( ? )  indicates that any single character can
occupy its position in a filename or filename extension.

Example:

Your default drive is  C. You want to see all files on the default
drive that begin with “TEST,” have any character in the next
position, end with “RUN,” and have the filename extension
of .EXE. You would give the following command:

C:\>dir test7run.exe <ENTER>

The resulting listing might look like this:

TEST1RUN.EXE
TEST2RUN.EXE
TESTBRUN . EXE
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The Asterisk ( * )

An asterisk indicates that any character can occupy its
position or any remaining position(s) in a filename or filename
extension.

Note that an asterisk in a filename does not affect the extension,
and vice versa.

The *.* specification is very powerful. It means
“ALL FILES IN THIS DIRECTORY.”
Use it cautiously!

If you accidentally use the specification in the DEL
command, you probably wish that you lived in another country
in another century, especially if you have been lazy in making
regular backup copies of your files.

Examples:

Your default drive is C. You want to list all directory entries on
the default drive that begin with TEST and have the filename
extension of .EXE. The command would look like this:

C:\>dir test*.exe <ENTER>

The resulting listing might look like this:

TEST.EXE
TEST1.EXE
TEST2RUN.EXE
TESTBRUN.EXE
TESTALL.EXE
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You want to display a listing of all files on the default drive that
begin with “ACCOUNTS” with any extensions. The command
would look like this:

C:\>dir accounts.* <ENTER>

To display a listing of all files on the default drive with any
filename and the extension of .TXT, the command would be:

C:\>dir *.txt <ENTER>

Your default drive is C, and without changing the default drive
you want to see the entire contents of the diskette in drive B.
The command would be:

C:\>dir b:*.* <ENTER>
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Special Functions

MS-DOS offers you several special functions that ease and
speed up your work. These functions are described in the
following sections.

Editing Keys

The computer has a special memory buffer called the template
which stores the most recently given command. When you type
a command, MS-DOS immediately stores it in the template, and
removes the previous command. This is handy for the following
purposes:

• You can repeat a command instantly by two keystrokes.

• If you make a mistake in a command line, you can edit
and retry it without having to retype the entire line.

• With minimal typing, you can edit and execute a com-
mand line similar to the previous one.

The most useful editing keys are described briefly below. All
editing keys are discussed in the MS-DOS® User’s Reference
Manual.

Let’s imagine that you just used this command:

C:\>copy a:memo.txt grpmeet.jan <ENTER>

Now, let’s see what you can do to it with the editing keys.

<F1> <F1> copies one character from the template to
the command line. So, with the above command
in the template, pressing <F1> once would
produce “c” to the command line, twice “o”,
three times “p”, etc.
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<F2> <F2> copies the contents of the template up to
the character you specify to the command line.
So, pressing <F2> and <T> would produce
“copy a:memo.” to the command line.

<F3> <F3> copies all remaining characters from the
template to the command line. So, pressing <F3>
would produce the entire sample command to the
command line.

<F4> <F4> skips over the characters in the template up
to the character you specify. So, pressing <F4>
and <T> would produce “xt grpmeet.jan” to the
command line.

<F5> <F5> saves the new line as the new template but
does not execute the command. So, if you edited
the example command to “copy a:memo.txt
c:memo2.txt” and pressed <F5>, this would be
the new template.

<ESC> <ESC> voids the current input and leaves the
template unchanged.

<DEL> <DEL> skips over one character in the template.
So, pressing first <DEL> three times and then
<F3> would produce “y a:memo.txt
grpmeet.jan” to the command line.

<INS> Enters/exits the insert mode.

Combination Example:

When typing the example command, you misspell “copy” as
“pocy”. If you press <ENTER>, a command error would occur.
Instead of retyping the whole line, save it as the new template
by pressing <F5>, and then edit it with this sequence:

C:\xDEL> <DEL> <F1> <INS> op <F3>

The corrected example command appears to the command line.
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Control Key Combinations

Some special functions require pressing <CTRL> or <SHIFT>
and another key simultaneously. Again, only the most useful
combinations are listed here.

<CTRL-C> This combination makes MS-DOS abort the
current command or program. So, use it
cautiously. When you press <CTRL-C>, the
characters AC are displayed on the screen.

If MS-DOS is executing a batch file when you
press <CTRL-C>, it interrupts the execution and
displays the following message:

Terminate batch job (Y/N) ?

If you press <Y> for “yes,” the commands left in
the batch file are not executed. If you press <N>
for “no,” the computer executes the commands
left in the batch file.

In case MS-DOS cannot execute a command and
prompts you with the message:

Abort, Retry, Fail?

press <A> to choose “Abort,” to end the
command. Do not use <CTRL-C> in this case.
Pressing <R> for “Retry” would make MS-DOS
try again. Pressing <F> for “Fail” would make
the operation end.

<CTRL-S> This combination stops the scrolling of a file’s
contents on the screen. To continue, press any
key.
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<CTRL-ALT-DEL>

This combination makes the computer stop all
operations to reload and restart MS-DOS.

Input and Output

MS-DOS assumes that input comes from the keyboard and out-
put is sent to the screen. However, you can redirect the flow of
command input and output. Input can come from a file instead
the keyboard, and output can go to a file or printer instead of the
screen. In addition, you can create “pipelines” allowing the out-
put from one command to become the input to another. A “fil-
ter” reads the input, transforms it in some way, and outputs it.
For example, SORT is a filter that can arrange input in alpha-
betical order.

Redirection, filters, and pipelines are functions you do not need
in the beginning. They are discussed in the MS-DOS® User’s
Reference Manual. We mention them here as examples of prac-
tical functions that you can study after you have mastered the
fundamentals.

Example:

To give you a hint of what you can do with these functions, let’s
take a quick look at redirecting output. With the DIR command
you can produce a listing of files in a directory. Usually the
command displays the listing on the screen. If you redirect the
command output to a file, you can, for example, edit the listing
with a text editor, and save it for future use. To redirect the lis-
ting of your current directory to a file named MYDIR.TXT, type

C:\>dir >mydir.txt <ENTER>

The directory listing is not displayed on the screen - the compu-
ter sends it to a file named MYDIR.TXT. In this way, you could
for example provide all your diskettes with printed
“tables of content”.
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Summary

A computer file is a collection of related material, analogous to
a file folder in a desk drawer. Both data and programs are stored
in files. For identification, files must have names which contain
certain parts placed in a certain order.

In addition to names, the computer needs a drive and path
specification to be able to find and work on the correct file.

This Chapter shows how to write file specifications. Once you
know how to access files, you will learn how to copy and delete
them, rename and print them, and display them on the screen.
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Naming Files

A file is  a collection of related material, like a file folder in a
desk drawer. For example, you can have a file containing the
names, addresses, and phone numbers of your friends, and
another with the same information on your business contacts.

Naming files is worth doing carefully and systematically. Well-
chosen names ease file management enormously. An ideal
name describes the contents of the file as uniquely as possible.
Here are some examples of typical names of files:

MAY89
SCHEDULE

BUDGET. 89
ACCOUNTS.FEB

MEET1212.88A MEMOTO.JIM

Develop your own naming system according to your needs. Put
extensions to good use. For example, you can easily sort your
files when you use .LTR for letters, .ENV for invoices, etc.

Characters Allowed in Names of Files

You can use the following characters:

A-Z a-z { } ( )
0-9 $ % # @ !

Some application programs may not let you use all of these
characters in names of files. Consult the manuals of the applica-
tion programs to check the naming conventions they use.

Characters Not Allowed in Names of Files

You should avoid using the following characters:

a a b [ ]
A A O \ I

Some application programs may not be able to handle names of
files that contain these characters.
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Filenames and Filename Extensions

The name of a file can have two parts: a filename and a
filename extension. They must be separated from each other by
a period ( . ). For example, a typical name looks like this:

NEWFILE.TXT

You can type the name of any file in uppercase or lowercase;
MS-DOS translates the characters into uppercase letters.

Filename

The first part (“NEWFILE” in the example above) is called
filename. Every MS-DOS file must have a filename. The
filename can be from one to eight characters long.

Filename Extension

The second part (“.TXT” in the example above) is called file-
name extension. The filename extension is optional, and can be
three or fewer characters long. Whenever you use the extension,
remember to use the period between the it and the filename.

Note that some application programs use their own standard
filename extensions.

Reserved Filenames

MS-DOS reserves some filenames for its own use, e.g. device
names and communications ports. You may not use them in
filenames. They are:

AUX
CLOCKS
COM 1, COM2,
COM3, COM4

asynchronous communications port
clock device
serial communications ports
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CON console (input from keyboard,
output to screen)

LPT1 , LPT2, LPT3 printer devices
LST printer device
NUL dummy file
PRN printer device

Even if you add device designations or filename extensions to
these filenames, MS-DOS still considers them as devices. So,
CON.MEM will still refes to the console and cannot be used as
the name of a file.

Note With the exception of CLOCKS, you can use the
names as filename extensions.

Standard Filename Extensions

There are no reserved filename extensions, but some extensions
have standard uses which you should know. Unless you are
explicitly instructed, avoid using the following extensions:

ASM COB FOR PAS
BAK COD FRM PIF
BAS COM LIB SYM
BAT DAT LST TMP
BLD DIF MAP VC
C EXE OBJ SYS
CAL FMT

For example, .BAT is reserved for batch files, .C for files
compiled with the C programming language, and .COM
and .EXE for executable files.
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File Management

Now it is time to take a look at the most frequently used file
management operations. Each operation is performed with a
command. In addition to the command, the computer expects
you to specify the name(s) of the desired file(s). Keep in mind
what you have just learned about drive specifications, names of
files, and wildcards. For more information on the commands,
consult the MS-DOS® User’s Reference Manual.

Creating a File

Normally, you create a file under an application program. For
example, text files are usually created under word processing
programs.

MS-DOS has a text editor called EDLIN which is useful for
creating and updating simple text files. As you do not need
EDLIN at this point, it is described in detail in the MS-DOS®
User’s Reference Manual.

Deleting a File

When you want to delete a file, use the DEL command. It
deletes files permanently. The synonym of the DEL command
is ERASE: instead of DEL you can type ERASE.
You can use wildcards (* and ?) in these commands. Use them
carefully so as to avoid deleting files you did not want to delete!

DEL *.* means “DELETE ALL FILES IN THIS
DIRECTORY.” Use this specification cautiously!
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As the *.* specification could prove very destructive, MS-DOS
asks:

Are you sure (Y/N)?

Press <Y> for “yes”, or <N> for “no.”

You can have MS-DOS ask you for confirmation before
deleting by including the /P switch in the DEL command.
This is described in the following examples.

Examples:

Your default drive is  C,  and you want to delete a file named
SALES.RPT from the same drive. At the prompt, type:

C:\>del sales.rpt <ENTER>

As the file you want to delete is in the default drive, you do not
need to include the drive specification in the command.

Your default drive is  C,  and you want to delete a file named
SALES.RPT from the diskette in diskette drive A. At the
prompt, type:

C:\>del a :  sales.rpt <ENTER>

As the file you want to delete is  in another drive, you must
include the drive specification in the command.

Your default drive is  C,  and you want to delete all files with the
extension .RPT from the root directory of a diskette in drive A.
At the prompt, type:

C:\>del a:*.rpt <ENTER>

To make MS-DOS ask you for confirmation before deleting,
include the /P switch in the command, after the name of the
file(s) to be deleted. The command looks like this:

C:\>del a:*.rpt /p <ENTER>
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Copying a File

With the COPY command you can copy one or more files from
or to the desired drive. When MS-DOS has performed the com-
mand, MS-DOS displays a message telling you how many files
were copied.

The copy automatically gets the same name as the original un-
less you specify another name. MS-DOS does not let you have
two files under the same name in the same directory. A name
can be repeated unchanged only when the files are in different
directories. If you copy a file with a name that is already used in
a directory, new information is written over the pre-existent file,
whose contents are thus lost.

You can use the wildcards (* and ?) with the COPY
command. However, be very careful with them to
avoid writing over any existing files.

Examples:

Your default drive is C. You have there a file named GRP-
MEET.JAN, and you want to copy it to the same drive and
directory under the name GRPMEET.FEB. At the prompt, type:

C:\xopy grpmeetjan grpmeet.feb <ENTER>

As the copy comes to the default drive, you do not have to
include its specification in the command.

Your default drive is C. You want to copy a file named GRP-
MEET.JAN to a diskette in drive A under the name GRP-
MEET.FEB. At the prompt, type:

C:\>copy grpmeetjan a:grpmeet.feb <ENTER>
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Your default drive is  C. You want to copy a file named
GRPMEETJAN to a diskette in drive A under the original
name. At the prompt, type

C:\>copy grpmeetjan a :  <ENTER>

As you do not change the name, you do not have to repeat it.

Your default drive is C. Without changing the default drive, you
want to copy GRPMEETJAN from a diskette in drive A under
the name GRPMEET.FEB to the same diskette. At the prompt,
type:

C:\>copy a:grpmeet.jan a:grpmeet.feb <ENTER>

Your default drive is  C. You want to copy all files with the
extension .DOC under the original names from a diskette in dri-
ve A to the default drive. At the prompt, type:

C:\>copy a:*.doc <ENTER>

Your default drive is  C. You want to copy all files from the root
directory under the original names to a diskette in drive A. At
the prompt, type:

C:\>copy a: <ENTER>
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Renaming a File

Sometimes you may want to change the name of a file. You can
do this with the REN command. You can also use the entire
word, RENAME, as a command. Renaming is useful, for exam-
ple, when you accumulate so many files of the same sort that
you want to change the names to something more specific.

Note that you can only rename files within the same directory.
So, if you already have a file by the same name in that particu-
lar directory, you cannot use the REN command. This also
means that you cannot both rename a file and move or copy it to
another directory at the same time.

You can use the wildcards (* and ?) with the REN(AME) com-
mand. The asterisk helps you to rename a group of files.
However, be careful so that you do not accidentally rename any
files that you did not want to rename.

Examples:

Your default drive is C, and it contains a file called RE-
PORT.TXT. Later you write more reports, and want to specify
the first more closely as ANNUAL.RPT. At the prompt, type:

C:\>ren reporLtxt annual.rpt <ENTER>

Your default drive is C. Without changing the default drive, you
want to rename BUDGET.TXT in drive A to BUDGET. 89. At
the prompt, type:

C:\>ren azbudget.txt budget.89 <ENTER>

To rename a group of STORY files to FABLE, type:

C:\>ren story.* fable.* <ENTER>
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Displaying a File on the Screen

If you want to view the contents of a text file on the screen, you
can use the TYPE command. Note that this command allows
you merely to view the contents, not work with them in any
way. Note also that TYPE can only display text files, not, for
example, program files (files with the extension .COM or
.EXE). If  you try to display a program file, you will only see
strange symbols. Some files may require you to run an applica-
tion program to view them.

Usually, files are longer than the screen can accommodate at
one time. As a default, the computer scrolls the file without stop-
ping until it reaches the end. The scrolling is faster than reading
speed. You can interrupt the scrolling by pressing <CTRL-S>,
and continue by pressing any key.

Examples:

You want to display a file named NOTES.DOC on the default
drive. At the prompt, type:

C:\>type notes.doc <ENTER>

Your default drive is A. Without changing the default drive you
want to display a file named NOTES.DOC in drive C. At the
prompt, type:

A:\>type c:notes.doc <ENTER>

If  you want to display the contents of a long text file one screen
page at a time, you can also use the MORE command. This
command is described in the MS-DOS® User’s Reference
Manual.
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Printing a File

If a printer is attached to your computer, you can print files with
the PRINT command. Before giving the command, make sure
that the printer is on, has paper, and is ready to print.

While a file is being printed, you can give other commands to
MS-DOS. You can run other programs, or create or modify
files. Because printing takes a lot of your computer’s capacity,
your further commands to MS-DOS may require a long time to
execute while you are printing a file. If you have a long file ,
you might schedule the printing for a time when you plan to be
away from your computer for a while.

To print files created with application programs, you may have
to use the application program’s print command.

Example:

You have a file named PHONE.NOS on a diskette in drive A,
and you want to print it on your printer. Your default drive is C.
Follow these steps:

At the prompt, type:

C:\>print a:phone.nos <ENTER>

If this is the first time you use the PRINT command after star-
ting up the system, MS-DOS displays the following question:

Name of list device [PRN] :

MS-DOS is prompting you for the name of the printing device
connected to your computer. This name is usually the commu-
nications port to which the printer cable is connected. If the
default value is correct, accept it by pressing <ENTER>. If not,
just type the new name and press <ENTER>

Now MS-DOS displays the following message:

Resident part of PRINT installed
A:phone.nos is currently being printed
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File Security

MS-DOS is  a powerful and useful tool for processing both
personal and business information. This information must be
protected, because errors can occur and information may be
misused. Especially if your work cannot be replaced or requires
a high level of security, you should protect your programs from
unauthorized use, modification, or deletion.

Simple but effective security measures are making backup
copies regularly, write-protecting your diskettes and locking
them away while not using them. The more vital the informa-
tion you work on, the more seldom should you content yourself
with just one set of backup copies. Provide the backup copies
with accurate labels, and write the date on them. Making
backup copies is described in Chapters titled Diskettes and
Fixed Disk.

If  you can lock your computer, take the key with you when you
stop working. Another good means of protection is  using a pass-
word, if this function is available.

You can consult your local Nokia Data representative for fast
backup and security features.
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Summary

The number of your files can quickly become large and un-
manageable. This is not surprising when you consider that the
computer’s fixed disk can store the equivalent of thousands of
pages of data.

There is another problem with having many files on one disk. If
many people share the computer, users may accidentally modify
or delete each other’s files - all it takes is two people using the
same names for different files in the same directory.

In an office you can separate and organize paper files, for
instance, by putting them into different file cabinets; accounting
in one and correspondence in another. MS-DOS allows you to
do something similar by putting your files into different directo-
ries which can contain sets of files and subdirectories.

Directories are managed much in the same way as files. The
following sections describe how you can display, create,
change, delete, copy, and rename directories.

If your computer has a fixed disk, directories are a must.
Though the computer is perfectly capable of finding a file in a
directory containing hundreds of files and subdirectories, you
are likely to get lost. However, try not to make the directory
trees too complicated. For most purposes, two or three
subdirectory levels are quite enough.
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Directories

Directories allow you to group your files to convenient hierar-
chical categories. When you create a directory, you actually re-
serve an area for files. The files you place in one directory are
kept separate from those in other directories. Thus, if you use
different directories, you can have two files by the same name
on the same drive. Still, try to avoid using the same names.

Directory Tree

A directory can contain any number of files. A directory can
also contain other directories that are called subdirectories.
Subdirectories, in their turn, can contain more files and sub-
directories. This creates a hierarchical multilevel directory
structure, like this:

[ ROOT

USERSBIN SYS ANNUAL.RPTTEXTS

FILE.1
SUE MARYJOE

DOC.TXT
| FORMSDOC.TXT PHONES

Figure 5-1 An Example of a Directory Structure
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In the Figure, the names enclosed in boxes represent directories,
and those without represent files. This Figure pops up in the
examples used in the rest of this Chapter.

Root Directory

Think of the multilevel directory structure as a tree: directories
are the branches and files are the leaves. Only this tree always
grows downwards. In this structure, the root is the top level.
MS-DOS creates the root automatically when you format a
diskette or disk.

Parent Directory and Subdirectories

Each directory that contains other directories is  called a parent
directory. The directories in a parent directory are its subdirecto-
ries.

Current Directory

The directory where you are working in at a given time is  your
current or working directory.

Avoid making complicated directory trees.
Usually, two or three levels are quite enough.

Naming Directories

As with files, naming directories is equally worth doing care-
fully and systematically. Well-chosen names ease directory
management considerably.

Everything that was said about naming files applies to naming
directories, too.
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Paths

When entering commands in a multilevel directory tree, you
must tell MS-DOS where in the structure the files are located.
For this you use paths. Paths are like driving instructions - “ta-
ke the next left, then the second right, and then it is the third
street on the left.” You simply need to know the path between
yourself and your destination, and then tell it  to MS-DOS.

The path is a sequence of directory names separated from each
other by a backslash ( \ ) .  The path may contain any number of
directory names up to a total length of 63 characters. If you
begin the path with a backslash, MS-DOS starts the search at
the root of the directory structure. Without the backslash MS-
DOS starts the search in the current directory and goes down-
ward from there.

Shorthand Notation

MS-DOS provides special shorthand notations for the current
directory and its parent directory, which you can see in the
directory listings.

You can use the shorthand notations for brevity when writing
paths. They are:

Single period refers to the current directory in all
multilevel directory structures.

, , Two periods refer to the parent directory of the
current directory (one level up).

You can neither create nor delete these notations. MS-DOS
does it for you.
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Examples:

The following examples are based on the directory tree in
Figure 5-1.

In each example, we are specifying the path to a file named
DOC.TXT that resides in the SUE directory.

1 . If you are in: the root directory
the path is: \USERS\SUE\DOC.TXT

2. If you are in: the BIN directory
the path is: . .\USERSsSUEDOC.TXT

3. If you are in: the USERS directory
the path is: SUE\DOC.TXT

4. If you are in: the MARY directory
the path is: . .\SUE\DOC.TXT

Note how you can use the two periods as shorthand to take
you one level up, instead of having to type the name of that
directory.

To retreat two levels up, you can use two sets of two periods.
For example, the path from the FORMS directory to the JOE
directory would look like this:

. X MOE
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Directory Management

Directories can hold both files and subdirectories. Directory
management resembles file management. However, the
commands are slightly different. They are described in the
following sections.

The effect of the commands you perform on files or directories
is generally restricted to the current directory. If you want to
perform a command on another directory without changing the
current directory, you must use a path.

Viewing Directory Contents

You can view the contents of a directory with the DIR
(Directories) command. If you do not specify a path, MS-DOS
displays the contents of your current directory.

DIR and Wildcards

The DIR command differs from other commands in that it
includes wildcards in commands by itself. Thus:

DIR equals DIR *.*
DIR MEMO equals DIR MEMO.*

The first command refers to “all files in this directory,” and the
second to “all files in this directory with the filename MEMO.”
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A Sample Directory Listing:

Your current directory is the root directory in drive C, and you
want to see the contents of the\USERS\SUE directory. At the
prompt, type:

CA>dir \users\sue <ENTER>

The listing might look like this:

Volume in drive C is VARIOUS
Directory of C:\USERS\SUE

<DIR> 7-08-88 17:18p

<DIR> 7-08-88 17:18p

FORMS <DIR> 10-10-88 10:10a

GRPMEET. JAN 13245 15-01-89 19: 15p

GRPMEET.FEB* 16021 15-02-89 9:44a

5 File(s) 7836320 :bytes free

The directory listing contains useful information. The very
first line displays the volume label, if there is one (here it is
“VARIOUS”). The next line displays the path to the directory
to be listed (here it is AUSERSSSUE”).

The line beginning with a single period ( . ) displays informa-
tion on that particular directory (here, \USERS\SUE) and the
line beginning with two periods ( . . ) on its parent directory
(here, \USERS). You can neither create nor delete these lines.
MS-DOS does it for you.

All directories (current, parent, and subdirectories) are marked
with <DIR>, and stamped with their creation date and time.

Files are stamped with the date and time of creation or last
modification, and the size of the file indicated in bytes.

The last line gives the total number of files and directories, and
the amount of available storage space. Subdirectories are not
counted separately; they are included in the “File(s)” count.

5-9



Directories

Viewing Large Directories

If you want to see the contents of a large directory, use the /P
switch to display the listing one screenful at a time. When you
are ready to study the next screenful, press any key. With the
switch, the command syntax for listing XUSERSXSUE is:

C:\>dir \users\sue /p <ENTER>

An alternative for stopping the scrolling is to press <CTRL-S>,
and continue by pressing any key.

DIR with File Specifications

If you include a file specification instead of a directory name,
MS-DOS displays directory information on the specified file
or  files. For example, to display information on a file named
ANNUAL .RPT on drive C,  type:

C:\xlir annuakrpt <ENTER>

Creating a Directory

You can create directories with the MD or MKDIR (Make
Directory) command. After MS-DOS has run this command, a
new directory exists with its “ . ” and “ . . ” notations.

To create a subdirectory in your current directory, use the MD
or MKDIR (Make Directory) command without any path.

To create directories anywhere else in the directory tree without
changing the current directory, include the appropriate path.

Because files and subdirectories are listed together, a file and a
subdirectory cannot have exactly the same name if they are in
the same directory. If  you have a subdirectory named JOE in
theXUSERS directory, you cannot create a file named JOE with-
out extensions in theXUSERS directory. You can create a file
named JOE1 or JOE.TXT in theXUSERS directory, though.
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Avoid making complicated directory trees!
Usually, two or three levels are enough.

Examples:

The following examples are based on Figure 5-1 .

Your current directory is the root in drive C,  and you want to
create a new directory named MEMOS. At the prompt, type:

C:\>md memos <ENTER>

Your current directory is the root directory in drive C,  and you
want to create a subdirectory named BILL under the directory
named USERS. At the prompt, type:

C:\>md \users\bill <ENTER>

Changing the Current Directory

The directory in which you work at any given time is your
current or working directory. If you use files in that directory,
you do not need to specify the path - the computer automatical-
ly starts searching for the file in the working directory. Note
that each drive has at least a root directory.

You can change the current directory with the CD or CHDIR
command (short for Change Directory).

How MS-DOS Sets the Current Directory

MS-DOS sets the current directory separately for each drive.
Changing the current directory on drive C does not change the
current directory on drive A. If you change the default drive
and then change it back, MS-DOS automatically returns to the
previous current directory.
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Suppose your current directory is A:\ (the root directory of
drive A), and you want to perform a command on a file named
FILE. 1 on drive C. Before you changed the default drive to A,
your current directory was C:\TEXTS. If you type:

A:\>type c:file.l <ENTER>

MS-DOS looks for FILE. 1 in C:\TEXTS (the current directory
of drive C). If FILE. 1 is  in, say, the C:\REPORTS directory,
MS-DOS cannot find the file and displays an error message.

If FILE. 1 is in the root directory of drive C (and unless the root
directory is  also the current directory) you must type:

A:\>c:\file.l <ENTER>

Examples:

Again, the examples are based on Figure 5-1. Your current
directory is MARY and you want to change it to JOE. At the
prompt, type:

C:\USERS\MARYxd \users\joe <ENTER>

Your current directory is MARY and you want to change it to
USERS. At the prompt, type:

C:\USERS\MARYxd . . <ENTER>

Note that the two periods take you one level up, to the parent
directory of your current directory.

Your current directory is MARY and you want to change it to
the root directory. At the prompt, type:

C:\USERS\MARYxd <ENTER>

As you see, two sets of two periods separated with a backslash
take you two levels up, to the parent directory of your current
directory’s parent directory.

You are in the root directory and want to change SUE to your
current directory. At the prompt, type:

C:\xd \users\sue <ENTER>
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Deleting a Directory

To delete a directory, use the RD or RMDIR (Remove Direc-
tory) command. Before you can delete a directory, you must
delete all its files with the DEL command, and all its sub-
directories with the RD command. You cannot remove the
single-period and two-period notations - MS-DOS does it for
you. If you try to delete a directory that is not empty, MS-DOS
displays the following message:

Invalid path, not directory,
or directory not empty

The RD and DEL commands function differently: RD can
remove an empty directory but not files, while DEL can remove
the files from a directory but not the directory itself.

Example:

FH This example is based on Figure 5- 1 . Your current direc-
tory is CAUSERS. You want to delete the subdirectory
named MARY. First, delete the contents of MARY. Type

C:\USERS>del \mary\*.* <ENTER>

[ 2 ]  To prevent accidental deletions, MS-DOS asks:

Are you sure (Y/N) ?

If  you surely want to delete all files in the directory,
press <Y> to answer “yes”. If not, press <N> for “no”.

[3] Now you can remove MARY. At the prompt, type:

C:\USERS>rd mary<ENTER>

If  your current directory was the root directory, you would type

C:\>rd \users\mary <ENTER>
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Copying One Directory

You can copy all files from one directory to another with the
COPY command and the *.* specification. After MS-DOS has
executed the command, it displays the number of copied files.

Examples:

Your current directory is\USERS\SUE, and you want to copy
its files to \USERS\JOE. At the prompt, type:

C:\USERS\SUE>copy *.* \users\joe <ENTER>

Your current directory is the root directory, and you want to
copy the files from \USERS\SUE to \USERS\JOE. Type:

C:\>copy \users\sue\*.* \users\joe <ENTER>

Copying Several Directories

With the XCOPY command and the /S switch you can also
copy the files that are in subdirectories.

Example:

Your current directory is\USERS\SUE, and you want to copy
its files and subdirectories to\USERS\JOE. Type:

C:\USERS\SUE>xcopy \users\joe /s <ENTER>
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Renaming a Directory

MS-DOS does not have a single command for renaming direc-
tories. Instead, use the following steps:

|~1~| Create a new directory with the desired name using the
MD command.

[2] Copy the files from the old directory to the new directo-
ry with the COPY *.* command (or the XCOPY *.* /S
command, if the directory has subdirectories).

0 Delete the contents of the old directory with the DEL
command. When MS-DOS asks “Are you sure (Y/N)?”,
answer “yes” by pressing <Y>.

Delete the old directory with the RD command.0
Examples:

This example is  based on Figure 5-1.

You are currently in the root directory of drive C. You want to
rename the \USERS\JOE directory to \USERS\MIKE. Give the
following commands:

C:\>md \users\mike <ENTER>

C:\>copy \users\joe\*.* \users\mike <ENTER>

C:\>del \users\joe\*.* <ENTER>

Press <Y> for “yes” when MS-DOS prompts:

Are you sure (Y/N) ?

[~5~| C:\>rd \users\joe <ENTER>

□ 0
0

0
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Checking for Errors

On each diskette and fixed disk partition, MS-DOS creates a
directory of contents and a File Allocation Table (FAT) which
stores information on the physical location of the files. You can
display a status report with the CHKDSK command. If any
error messages are displayed, see the MS-DOS® User’s
Reference Manual.

If you include a file specification in the CHKDSK command,
MS-DOS displays a status report for the diskette or fixed disk
partition and for the individual file.

A sample status report:

Your default drive is C,  and you want a status report on a
diskette in drive A.  At the prompt, type:

C:\>chkdsk a:  <ENTER>

Or, your default drive is C,  and you want to display its status
report. At the prompt, just type

C:\>chkdsk <ENTER>

If everything is in order, the status report will look something
like this (the figures are imaginary):

Volume PROGRAMS created 10-19-1988 2:13a

362496 bytes total disk space
347136 bytes in 13 user files

15360 bytes available on disk
655360 bytes total memory
538688 bytes free

The status report contains useful information. Note the last two
lines: in addition to checking the condition of your diskette or
fixed disk, you can use CHKDSK to find out whether you have
enough RAM memory space for an application program.
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Using Paths to Application Programs

Besides MS-DOS, you probably use application programs, e.g.
a word processor. They reside in their own directories, perhaps
on different drives, too. To start an application program, you
have to change to its directory, and give a starting command -
a process which may require several steps. To save time and
tedium, you can alter the PATH command in the AUTO-
EXEC.BAT file, so that you will be able to start the application
from any drive or directory at your convenience.

As default, the PATH command in AUTOEXEC.BAT already
contains the paths to the MS-DOS directories. This is why you
can use MS-DOS commands anywhere, without changing
directories or specifying paths.

The PATH command can contain paths to several program
directories in different drives. Just separate them with a semi-
colon ( ; ). You can alter the PATH command of AUTO-
EXEC.BAT with an editing program, for example, with the
EDLIN program of MS-DOS. Formore information, see the
MS-DOS® User’s Reference Manual.

Examples:

To check the current paths, type:

C:\>path <ENTER>

MS-DOS displays the current paths on the screen, like this:

PATH=C : \ ; C : \SYS ; C : \NET

To add a path in the above example to a word processor called
SUPERTEXT in D:\SPRTXT, modify it to the following form:

PATH=C : \ ; C : \SYS ; C : \NET; D : \SPRTXT

To remove current paths from the PATH command, type:

C:\>path ; <ENTER>

5-17



Directories

Using Paths to Data Files

In addition to application programs, you probably need data
files that are not in the current directory or drive. To establish
a path to a directory containing data files, use the APPEND
command. It works in the same way as the PATH command.

Like PATH, APPEND is useful in AUTOEXEC.BAT. You can
have paths to several data file directories by separating them
with a semicolon ( ; ).

APPEND needs to be entered only once, when starting MS-
DOS.

Examples:

To display the current paths to data files, type:

C:\>append <ENTER>

MS-DOS displays the current paths on the screen, like this:

APPEND=C : \DATA

To remove the current paths to data files, type:

C:\>append ; <ENTER>
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Diskettes

Summary

The diskette is an inexpensive and practical mass storage device
on which, when necessary, you can easily transfer information
from one computer to another.

Before you can use new diskettes for storing infonnation, you
must format them. Formatting structures a diskette so that
MS-DOS can find information on it. Formatting is done with
the FORMAT command which also checks the diskette for
defective spots.

The last part of this Chapter is devoted to a very important
subject: making backup copies. No matter how busy you are,
always make backup copies of all your diskettes! The more
irreplaceable your work is, the less seldom should you content
yourself with just one set of backup copies. Put accurate labels
on your backup diskettes, and keep them constantly up to date.
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Diskettes

Diskettes are flat, round slices of a special plastic, coated with
magnetic oxide. You can record or erase data on a diskette as
many times as you like, as you can with cassette tapes. Since
dirt, oil, or any other foreign matter can harm the magnetic
surface, the actual diskette is encased in a plastic jacket.

Only a small portion of the diskette is exposed through an
opening called the head slot. Through this slot, the diskette
drive’s read/write head can access data stored on the diskette.

Tracks and Sectors

Formatting structures a diskette into concentric circles called
tracks. Tracks, in turn, are divided into sectors.

When the computer reads from or writes to a diskette, the
read/write head of the diskette drive moves to the track where
the desired data is located and searches for the required sectors.
When the computer is writing data on a diskette, the read/write
head moves to the first track where there is an available sector
to start the writing. When there are no more free sectors on the
track, the computer simply continues from the next track with
available space.
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Sizes and Capacities

Size refers to the visible size of a diskette. The most frequently
used sizes are 3.5 and 5.25 inches. A 3.5-inch diskette is used in
a 3.5-inch diskette drive, and a 5.25-inch diskette in a 5.25-inch
diskette drive.

Capacity refers to the invisible “size” of a diskette, i.e. its
storage capacity .We recommend that you use diskettes with the
largest possible capacity accepted by your diskette drive. You
can identify the capacity by looking for the letter codes on the
diskettes:

DD Short for “Double Density.” For a 3.5-inch
diskette, the DD-capacity is 720 kilobytes;
for a 5.25-inch diskette, 360 kilobytes.

HD Short for “High Density.” For a 3.5-inch
diskette, the HD-capacity is 1 .44 megabytes;
for a 5.25-inch diskette, 1.2 megabytes.

See the manual of your computer for the capacity of your
diskette drive(s). Use HD-diskettes in a high-capacity drive.

6-5



Diskettes

Write-protecting Diskettes

Sometimes diskettes are write-protected. This means that you
can read the information on the diskette, but you cannot add,
change, replace, or erase it.

You should always write-protect important diskettes. Otherwise
you may accidentally change or even destroy important
information. Be especially careful to write-protect your backup
diskettes.

Write-protecting 3.5-inch Diskettes

A 3.5-inch diskette has a small window near the bottom in
the left front comer. When the window is open, the diskette is
write-protected. When you want to write-protect a 3.5-inch
diskette, open the window by pressing down the small lever
behind it. When you want to cancel the write-protection, close
the window by raising the lever up. A 3.5-inch, HD-diskette has
two windows; the left for write-protection, the right for telling
the diskette drive that the diskette is of HD type.

Write-protecting 5.25-inch Diskettes

A 5 .25-inch diskette has a small notch near top in the right
front comer. When the notch is covered with a write-protect
tab, the diskette is write-protected. The write-protect tabs are
contained in diskette boxes. When you want to cancel the
write-protection, remove the tab.
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Formatting Diskettes

Before you can use new diskettes, you must format them with
the FORMAT command. This command structures the diskette
so that MS-DOS can find information on it, and also checks the
diskette for defective spots.

You can also reformat diskettes that are already in use, but
remember that reformatting destroys the possible contents.
Below are separate instruction sections for systems with a fixed
disk and systems with two diskette drives. As the command
itself is the same for all systems, it is discussed first.

The FORMAT Command

The command consists of the word “format”, a space, the name
of the drive holding the diskette to be formatted, and finally, in
some cases, one or more switches.

As described above, switches are used for specifying how the
command should be executed. A switch is a single-character
code, preceded by a slash ( / ). When you format diskettes, you
may need the following switches.

/V This switch is optional. If you use it in the
FORMAT command, you can give the diskette a
name (a volume label). It is practical to give a
name to a new diskette. Well-chosen label helps
you keep your diskettes organized. The
maximum length of the label is eleven (11)
characters.
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IS The optional /S switch copies three files to the
diskette: two hidden files and a third file named
COMMAND.COM which contains several
important commands. The purpose of the three
files is to let you load MS-DOS from the
diskette. Diskettes formatted with the /S switch
are called system-formatted. However, as /S
reduces the amount of free space on the diskette,
use it only when you want to make a diskette
with which you can start MS-DOS.

/4 You must use the /4 switch when you format a
5.25-inch, 360-kilobyte, DD-diskette in a
5.25-inch, 1.2-megabyte, high-capacity diskette
drive.

/N :9 /T:80 Y ou must use this combination when you format
a 3.5-inch, 720-kilobyte, DD-diskette in a
3.5-inch, 1.44-megabyte, high-capacity diskette
drive.

To format diskettes, follow the instructions in either of the next
two sections, depending on your system.

Systems with One Diskette Drive

If you have two diskette drives and no fixed disk, go directly to
the next section.

If you have a fixed disk, we assume that you have copied
MS-DOS to drive C, and that drive C is the default drive.

Formatting HD-Diskettes in High-Capacity Drives

Following these instructions, you can format a 3.5-inch,
1.44-megabyte HD-diskette in a 3.5-inch, 1.44-megabyte, high-
capacity diskette drive, or a 5.25-inch, 1.2-megabyte,
HD-diskette in a 5.25-inch, 1.2-megabyte, high-capacity drive.
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Fl At the prompt, type:

C:\>format a: /v <ENTER>

[2] You are prompted to insert the diskette to be formatted
in drive A. Insert the diskette and press <ENTER> when
you are ready. Formatting begins.

[3] If you used the /V switch, you are prompted for a
volume label for the diskette. The maximum length of
the label is 1 1 characters. If you want to label the
diskette, enter the desired label and press <ENTER>. If
you do not want to give a label, just press <ENTER>.

[4]  You are asked:

Format another? (Y/N)

If you want to format more diskettes with the same
options, answer “yes” by pressing <Y> and <ENTER>.
You are prompted for a new diskette. Replace the
formatted diskette with a new diskette, and press <EN-
TER> when ready.

If you do not want to format more diskettes, answer “no”
by pressing <N> and <ENTER>.

Formatting DD-Diskettes in High-Capacity Drives

To format a 5.25-inch, 360-kilobyte, DD-diskette in a
5.25-inch, 1.2-megabyte, high-capacity diskette drive, you must
use the following command:

C:\>format a: /4 <ENTER>

To format a 3.5-inch, 720-kilobyte, DD-diskette in a 3.5-inch,
1.44-megabyte, high-capacity diskette drive, you must use the
following command:

C:V>format a: /n:9 Zt:80 <ENTER>
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Systems with Two Diskette Drives

This section is for systems with two diskette drives but no fixed
disk.

Formatting HD-Diskettes in High-Capacity Drives

Following these instructions, you can format a 3.5-inch,
1.44-megabyte HD-diskette in a 3.5-inch, 1.44-megabyte,
high-capacity diskette drive, or a 5.25-inch, 1.2-megabyte,
HD-diskette in a 5.25-inch, 1.2-megabyte, high-capacity drive.

171 Make sure that the MS-DOS diskette is in drive A.

|~2~| At the prompt, type:

A:\>format b: /v <ENTER>

[3]  You are prompted to insert the diskette to be formatted
in drive B. Insert the diskette and press <ENTER> when
you are ready. Formatting begins.

|~4~| If you used the /V switch, you are prompted for a
volume label for the diskette. The maximum length of
the label is 1 1 characters. If you want to label the
diskette, enter the desired label and press <ENTER>. If
you do not want to give a label, just press <ENTER>.
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|~5~| You are asked:

Format another? (Y/N)

If you want to format more diskettes with the same
options, answer “yes” by pressing <Y> and <ENTER>.
You are prompted for a new diskette. Replace the
formatted diskette with a new diskette, and press <EN-
TER> when ready.

If you do not want to format more diskettes, answer “no”
by pressing <N> and <ENTER>.

Formatting DD-Diskettes in High-Capacity Drives

To format a 5.25-inch, 360-kilobyte, DD-diskette in a
5.25-inch, 1.2-megabyte, high-capacity diskette drive, you must
use the following command:

A:\>format b: /4 <ENTER>

To format a 3.5-inch, 720-kilobyte, DD-diskette in a 3.5-inch,
1.44-megabyte, high-capacity diskette drive, you must use the
following command:

A:\>format b: /n:9 /t:80 <ENTER>
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Backing Up Diskettes

The importance of making backup copies can never be exag-
gerated. You should always make a backup copy of every
diskette that you have. The more irreplaceable the information
you work on, the less seldom should you content yourself with
just one set of backup copies. Provide the backup diskettes with
absolutely accurate and dated labels. Remember also to update
your backup diskettes regularly.

The DISKCOPY Command

You can make backup copies of diskettes with the DISKCOPY
command. You executed this program when you made backup
copies of the MS-DOS diskettes.

You can use unformatted diskettes, too: DISKCOPY will
format them while copying, using the default options valid for
the drive. If you use a diskette that already contains something,
the contents will be written over and lost.

The diskette to be copied and the future backup diskette must be
of the same size and capacity.

Note You cannot use DISKCOPY to back up a fixed
disk. This is done with the BACKUP command,
and described in the following Chapter. You
cannot use the DISKCOPY command to copy
the contents of a diskette to or from a fixed disk,
either. Instead, you must use the COPY or
XCOPY commands. They are described in detail
in the MS-DOS® User’s Reference Manual.

Follow the instructions in one of the following sections,
depending on your system. The first is written for systems with
one diskette drive, and the second for systems with two diskette
drives.
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Systems with One Diskette Drive

This section is written for systems with one diskette drive. In
the following instructions, we assume that your default drive
is C.

[7| At the prompt, type:

C:\xiiskcopy a: a :  <ENTER>

[2] The following message is displayed:

Insert SOURCE diskette in drive A:

Press any key when ready . . .

Insert the diskette to be copied (SOURCE) in drive A,
and press any key. The computer begins to copy the
contents of the diskette temporarily into memory. A
message similar to the one below is displayed:

Copying 80 tracks

9 Sectors/Track, 2 Side(s)

[3] When the contents are copied, the following message is
displayed:

Insert TARGET diskette in drive A:

Press any key when ready . . .

Insert the new backup diskette (TARGET) in drive A,
and press any key. The TARGET diskette must be the
same type as the SOURCE diskette. The computer
copies the contents of the diskette to be backed up from
memory to the new backup diskette.
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[~4~| If you are using an unformatted diskette, the program
formats it while copying, and displays the following
message:

Formatting while copying . . .

You may be asked to change diskettes until everything
has been copied to the new diskette. Be careful not to
mix up the diskettes.

0 When the entire contents are copied, the following
message is displayed:

Copy complete

Copy another? (Y/N)

If  you do not want to copy more diskettes with the same
options, answer “no” by pressing <N>.

The TARGET is now an exact copy of the SOURCE diskette.
Provide the backup copy with a label identical to that of the
SOURCE diskette. Marie the date on the backup, and store it in
a safe place.
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Systems with Two Diskette Drives

This section is  for systems with two diskette drives. Follow
these steps:

Fl If your computer does not have a fixed disk, insert the
MS-DOS diskette in drive A.

If your computer has a fixed disk, we assume that you
have installed MS-DOS on it, and that drive C is your
default drive. At the prompt, type:

C:\>diskcopy a:  b: <ENTER>

If you run the command from drive A,  the prompt
is A:\>.

[2] The following message is displayed:

Insert SOURCE diskette in drive A:

Insert TARGET diskette in drive B:

Press any key when ready . . .

SOURCE is the diskette to be copied, TARGET the new
backup diskette. The diskettes must be the same type.

[3] If the computer has a fixed disk, insert the SOURCE
diskette in drive A, and the TARGET diskette in drive B.
When you are ready, press any key. The copying starts.

If  the computer does not have a fixed disk, remove the
MS-DOS diskette from drive A. Insert the SOURCE
diskette in drive A, and the TARGET diskette in drive B.
When you are ready, press any key. The copying starts.
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[4]  If you are using an unformatted diskette as the new
backup diskette, the program formats it while copying,
and displays the following message:

Formatting while copying . . .

□ When the entire contents are copied, the following
message is displayed:

Copy complete

Copy another? (Y/N)

If  you do not want to copy more diskettes with the same
options, answer “no” by pressing <N>.

Now the TARGET diskette in drive B is an exact copy of the
SOURCE diskette in drive A. Provide the backup copy with a
label identical with that on the SOURCE diskette. Mark the date
on the backup diskette, and store it in a safe place.
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Fixed Disk

Summary

A fixed disk is a mass storage device installed permanently
inside a computer. It has several advantages over diskettes. For
example, it can store far more information, and also access that
information faster.

Before you can store information on a fixed disk, it must be
prepared for use by partitioning and formatting. The fixed disks
of the computers delivered by Nokia Data are already
partitioned and formatted.

The bulk of the Chapter is devoted to an extremely important
subject: making backup copies. You will leam how to make
backup copies of the contents of the fixed disk on diskettes. For
making backup copies of large fixed disks, it is advisable to
purchase a tape backup device.

This Chapter also gives instructions for moving the equipment.
Just before you move turn the power off, make backup copies
of all your files, and run the PARKHD program. You do not
need any special commands for starting to use the fixed disk
again after moving the equipment and cabling it again.
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Fixed Disk

The fixed disk is actually one or more disks sandwiched on top
of each other, with spaces between the disks for read/write
heads. The fixed disk has a large storage capacity: typically
dozens of megabytes, or  even more. As the name indicates, the
fixed disk is installed permanently inside the computer. The
fixed disk is sometimes also called hard disk or Winchester disk.

Tracks, Sectors, and Cylinders

Data and programs are stored on concentric circles called tracks
that are created on the disk during formatting. Because of the
large recording capacity, the fixed disk probably has bad tracks.
MS-DOS recognizes the bad tracks and does not use them.

Tracks are divided into sectors.

Tracks on the different disks that are at the same distance from
the center form a cylinder.
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Backing Up the Fixed Disk

The fixed disk is not as easily damaged as diskettes because
it is protected by its own cover and the case of the system unit.
However, do not let this lead you think that there is no need to
make a backup copy. The importance of making backup copies
cannot be exaggerated. Make a backup copy as often as you
have accumulated so much new or modified data that you
would really hate yourself for losing them.

If you have a fixed disk with a very large capacity, say,
70 megabytes, we recommend that you purchase a tape backup
device.

The BACKUP Command

You can make a backup copy of the fixed disk to diskettes with
the BACKUP command. This command has several optional
switches with which you can perform the command differently
according to your needs. Not to complicate things now,
we give you just one example here. Later, you can consult the
MS-DOS® User’s Reference Manual to leam more.

The following BACKUP command copies the contents of the
desired fixed disk drive onto diskettes. When one diskette fills
up, you are prompted for another. To minimize the number of
resulting backup diskettes, use diskettes with the largest possi-
ble capacity accepted by your diskette drive.

The diskettes must be formatted and, preferably, empty.
BACKUP does not work with unformatted diskettes. Before
beginning, make sure that you have a sufficient number of
formatted diskettes. (Divide the capacity of the fixed disk
partition by the capacity of the diskettes you are going to use,
and you get the sufficient number.)
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Provide the backup diskettes with numbered and dated labels.
Use the numbering because if you need to restore the files to the
fixed disk later on, you must do it in the same order as they
were copied.

Example:

|T| Y ou want to make a backup copy of the fixed disk drive
C. At the prompt, type:

C:\>backup c:\*.* a: is <ENTER>

The /S switch tells the program to copy also the files in
the possible subdirectories. Note that the /S switch in the
BACKUP command has a different function than in the
FORMAT command.

|~2~| You are prompted for a diskette. Insert the empty backup
diskette number 1 in drive A.

When you are ready, press any key. If there are any old
files on the root directory of the diskette, they will be
written over and lost. The program displays the names of
the files as they are copied.

[3] When the diskette fills up, you are prompted for another.
Remove your backup diskette number 1 from drive A,
and insert the empty backup diskette number 2. Follow
the instructions on the screen.

Repeat the procedure until the entire contents of the partition
have been copied onto diskettes.

The next section describes how you can restore the files copied
with the BACKUP program onto the fixed disk.
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Restoring Files to Fixed Disk

BACKUP diskettes are unusable in normal processing. Their
contents must first be restored back onto the fixed disk with the
RESTORE command. Make sure you restore the files in the
right order.

Example:

Fl You want to restore the contents of the fixed disk drive
C. At the prompt, type:

C:\>restore a: c:\*.* /s <ENTER>

The /S switch makes sure that the program creates all
required subdirectories on the fixed disk. If the fixed
disk and backup diskettes contain files with similar
names in the same directories, the files on the backup
diskettes will be copied over the files on the fixed disk.

[2] You are prompted for a diskette. Insert the backup
diskette number 1 in drive A, and press any key.
The restoring begins.

|~3~| When the contents of the diskette are restored on the
fixed disk, you are prompted for another diskette.
Remove the backup diskette number 1 from drive A,
and insert the backup diskette number 2. Follow the
instructions on the screen.

Repeat the procedure until you have restored the entire contens
of the whole partition. Be careful to insert the diskettes in the
correct order.
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Partitioning the Fixed Disk

The fixed disks of the computers delivered by Nokia Data are
already partitioned. If, for some reason, you want to change the
original partitioning, run the FDISK program. Because it is not
likely that you will need to do this, FDISK is described in detail
in the MS-DOS® User’s Reference Manual.

Partitioning simply means dividing the fixed disk into separate
areas. These areas are then reserved for operating systems, for
example MS-DOS.

Each partition gets a drive letter: the first is C, the second D,
and so on. The letters A and B are always reserved for diskette
drives - even when the computer has only one diskette drive.
Using these letters, the partitions are referred to in the same
way as diskette drives A and B.
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Formatting the Partitions

The partitions on the fixed disks of the computers delivered by
Nokia Data are already formatted. However, if you change the
original partitioning of the fixed disk with the FDISK program,
you must format the changed or new partitions before you can
use them. This is done with the FORMAT command.

Formatting the partitions of the fixed disk is  described in
detail in the MS-DOS® User’s Reference Manual next to the
description of FDISK.
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Securing the Fixed Disk for
Transport

If  you move the equipment, follow these steps:

FH Make a backup copy of the contents of the fixed disk,
for example on diskettes using the BACKUP command.
In this way, you make sure that you do not lose any infor-
mation during transport due to vibration or other hazards.

|~2~| Just before you turn the power off, run the PARKHD
program. PARKHD secures the read/write heads for
transport. At the prompt, type:

C:\>parkhd <ENTER>

A message is displayed to inform you when the
read/write heads are secured for transport.

|~3~| T urn the power off from all pieces of equipment.

|~4~| If  possible, use the original packing material and boxes.

After moving and recabling the equipment, you do not need any
special command to start using the fixed disk again. Simply turn
the power on.

Run PARKHD and turn the power off even if you only move
the computer from one desk to another.
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asch
Short for American Standard Code for
Information Interchange. ASCII is a coding
scheme for the characters of the keyboard. See
also Code tables.

Application

A program that applies to a specific set of tasks,
e. g. word processing, spreadsheets, presentation
graphics, and project management.

Assembler

The Assembler translates code from the
Assembly language into binary machine
language.

AUTOEXEC.BAT

A special MS-DOS file run each time you start
or reset the computer. This file can also be used
to customize the MS-DOS operating system to
meet individual needs.

Backup copy

A copy made of the contents of a diskette or
fixed disk.

BASIC

Short for Beginner’s All-purpose Symbolic
Instruction Code. BASIC is a general-purpose
programming language.
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Batch processing

Batch processing allows a whole sequence of
commands to be executed by entering the name
of the batch file as a command. Batch files have
an extension of .BAT.

Binary system

Number system where the base is 2. The binary
system uses two digits: 0 and 1.

Bit

Short for binary digit. Bit is the smallest unit of
information for the computer.

Booting

Starting and loading MS-DOS into memory.

bps

Short for bits per second. Indicates the speed of
data transfer.

Buffer

A special area in the computer’s memory that
MS-DOS uses to store data temporarily.

Byte Set of eight bits. A byte can store one character.
Memory space is measured in kilobytes (kB,
1024 bytes) or megabytes (MB, 1024 kilobytes).

Character

A letter, number, or symbol that you type at your
keyboard or see on your screen.
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Code pages

A code page contains a set of characters specific
to the corresponding language or country. The
code pages used by the system are determined by
the country code in the CONFIG.SYS file.
Current code pages can be changed, for example,
to print text that contains characters that the
current code page does not include. See the
MS-DOS® User’s Reference Manual.

Code tables

A numeric code is assigned to each character that
the computer system can process. Several coding
schemes are used currently. The 7-bit ASCII
code table allows 128 characters. To include
special characters needed on national keyboards,
other characters have been left out. In the 8-bit
extended ASCII table, the number of characters
is 256. The standard American alphabet takes the
first half, and the special characters are in the
second. The Roman 8, which is used on a
number of laser printers, resembles the extended
ASCII, with a few exceptions.

Command

A short program that tells MS-DOS how to do
a specific task. MS-DOS commands are divided
into internal and external commands, depending
on where they reside. Internal commands form
a part of the command processor (the
COMMAND.COM file) while each external
command is placed in its own file.
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Compiler

A program that translates a program written in
a high-level language like C or Pascal into
machine language.

Configuration

The functional arrangement of a computer
system.

CONFIG.SYS

A special MS-DOS file read each time the
computer is started or reset. CONFIG.SYS
contains a list of the installable device drivers
and other information used to configure the
MS-DOS operating system.

Cursor

A blinking line or small box indicating the
location on the screen.

Default drive

The drive on which any read and write
operations are performed, unless a different drive
is specified.

Device

A piece of equipment that performs a specific
function, for example a printer.

Device error

An error occurring when one of the computer’s
devices, usually a diskette drive or printer, is not
ready to perform a task, or has a problem. When
a device error occurs, MS-DOS displays a device
error message.
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Directory

A feature that allows the organizing of files into
convenient groups kept separate from each other
on a fixed disk or diskette. In addition to files,
directories can contain subdirectories.

Disk operating system

See Operating system.

Diskette

A mass storage device for computers. The
commonly used sizes are 3.5 and 5.25 inches,
and several capacities are available.

Diskette drive

A piece of hardware attached to the computer.
Diskette drives are used for reading information
from and writing information to diskettes.

Driver

A software module for operating a device, such
as the monitor.

Editor

A program for creating and editing text files. The
MS-DOS line editor is called EDLIN.

EPROM

Erasable Programmable Read Only Memory.
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Error message

Message displayed on the screen after MS-DOS
detects a problem while trying to process a
command or program. See MS-DOS® User’s
Reference Manual for the appropriate response
to each error message.

ESC sequence

A control sequence whose first character is  ESC.
The ESC sequences are needed to operate
peripherals.

Executable file

A program file that has been translated
(compiled) into binary machine language. An
executable file has an extension of .COM or
.EXE.

Execution

Running a program.

File

A collection of related information, comparable
with a file folder in a filing cabinet. Programs are
also stored in files. A file must have a name, so
that the computer can find in on the fixed disk or
diskette.

Filename

The first and compulsory part of the name of a
file. A filename can be from one to eight
characters in length.
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Filename extension

The second and optional part of the name of a
file. Extensions begin with a period (.) and
contain from one to three characters. Some
application programs supply their own
extensions for files they create.

Fixed disk

A mass storage device installed inside the system
unit. A fixed disk can store much more
information than a diskette, and the computer
can retrieve information from it faster. Also
called hard disk or Winchester disk.

Floppy disk

See Diskette.

Format

A framework created on diskettes and the fixed
disk. Formatting prepares the mass storage
medium for use.

Hard disk

See Fixed disk.

Hardcopy

A function which produces a paper copy of the
screen.

Hardware

The physical components of a computer system.
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Hexadecimal system

A number system where the base is 16. The
hexadecimal system uses the digits from 0 to 9,
and the letters from A to F. The letters
correspond to the numbers from 10 to 15 of the
decimal system.

Input

Information sent to the computer, for example
from the keyboard.

I/O

Short for Input/Output.

Kilobyte (kB)

One kilobyte equals 1024 bytes. See also Byte.

Line parameters

Parameters that determine how information is
passed to external devices such as printers and
modems.

Logical partition

A separate area on a fixed disk, referred to and
used in the same way as diskette and fixed disk
drives.

Mass storage device

A device for storing information over long time
periods, for example the fixed disk and diskettes.

Megabyte (MB)

One megabyte equals 1024 kilobytes. See also
Byte.
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Memory

Storage place for programs and commands.

Microprocessor

A processor contained on one integrated-circuit
chip. The processor is the part that performs the
instructions sent to the computer.

Modem

A device that converts characters into signals,
and vice versa. Modems are used for example for
sending data over telephone lines.

Operating system

A group of programs that act as a translator
between the user and the computer. MS-DOS is
an operating system.

Output

Information sent by the computer, for example to
the monitor or printer.

Overflow

Loss of data resulting from an insufficient
amount of storage space.

Partition

An area on the fixed disk. Each partition gets a
drive letter, just like the diskette drives.

Program

A set of instructions, written in computer
language, that tells the computer how to perform
a task.
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Prompt

Indicates when the system is  ready to receive a
command. The MS-DOS prompt usually consists
of the default drive letter, a colon ( : ) ,  and the
greater-than sign, such as C:>. Other programs
will use different prompts. For example, EDLIN
uses an asterisk ( * ).

RAM

Short for Random Access Memory. RAM
memory is volatile, a place where the computer
puts the information that it is currently working
on.

Read/write head

Read/write head writes information to and reads
information from a mass storage device.

Register

A small memory area which has no address.

ROM

Short for Read Only Memory. ROM memory
contains information that you can only read, not
change in any way.

Roman 8

See Code tables.

Scrolling

The movement of text on the screen.
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Sector

The magnetic tracks on a diskette or fixed disk
are divided into sectors of certain size. See also
Track.

Software

Computer programs.

Template

A storage place for the most recently given
MS-DOS command.

Track

Magnetic circles created on a diskette or fixed
disk during formatting. The tracks are used for
storing information. See also Sector.

Utility program

An additional program delivered with MS-DOS
which facilitate the operation of the system.

Volume label

An internal name given to a diskette or fixed
disk partition.

Winchester disk

See Fixed disk.

Write protection

Protecting the contents of a diskette from being
changed, deleted, or overwritten.
Write-protecting does not prevent the reading of
information from diskette.
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Command Summary

MS-DOS Commands

This Appendix contains a list of MS-DOS commands. Each
command is described here very briefly. For more detailed
descriptions, see the MS-DOS® User’s Reference Manual.

APPEND Sets a search path for data files. Cannot be used
for searching program files.

ASSIGN Assigns a drive letter to a different drive.

ATTRIB Sets or displays file attributes.

BACKUP Backs up one or more files from a fixed disk or
diskette to diskette(s).

BREAK Sets CTRL-C check.

CALL A batch processing command that calls one
batch file from another without ending itself.

CHARLOADLoads characters for NDC, EGA, and VGA.

CHCP Displays or changes the current code page for
the command processor COMMAND.COM.

CHDIR (CD) Changes directories or displays the current
directory.

CHKDSK Scans the directory of the default drive or
designated drive and checks for consistency.

CLS Clears the screen.

COMMAND Starts the command processor, processes internal
MS-DOS commands.

COMP Compares the contents of two sets of files.

COPY Copies the specified file(s).
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CTTY Lets you change the device from which you
issue commands.

DATE Displays and sets the date.

DEL (ERASE)

Deletes the specified file(s).

DIR Lists the contents of a given directory.

DISKCOMP Compares disks.

DISKCOPY Copies diskettes.

ECHO A batch processing command that turns the echo
feature on or off, or displays the current setting.

ERIGRAPH Prints screens.

ERIMODE A mode program for certain computers.

ERITABL Selects code page in the graphics mode.

EXE2BIN Converts executable (.EXE) files to binary
format.

EXIT Exits the command processor and returns to the
previous level.

FASTOPEN Decreases the amount of time needed to open
frequently-used files and directories.

FC Compares files and displays differences between
them.

FDISK Configures fixed disks for MS-DOS.

FIND Searches for a specific string of text.

FONT Loads characters above 127 for Hercules.

FOR A batch processing command that performs a
command to a set of files.

B-4



Command Summary

FORMAT Formats a diskette or fixed disk to receive
MS-DOS files.

GOTO A batch processing command that processes
commands starting with the line after the
specified label.

GRAFT ABL Loads a table of graphic characters.

GRAPHICS Prepares MS-DOS for printing characters.

HGC Configures NDC to be Hercules.

IF A batch processing command that performs a
command if a condition is met.

JOIN Joins a disk drive to a path.

KDEF Configures the key codes.

KEYB Loads a keyboard program.

KP Locks the keyboard and changes the password.

LABEL Labels diskettes and fixed disk partitions.

MEM Displays memory information.

MKDIR (MD)

Makes a directory.

MODE Sets operation modes for devices.

MONSAVE Switches off the monitor while it is not used.

MORE Displays output one screenful at a time.

NDC_CURS Emulates the shape of the NDC cursor.

NSLFUNC Loads country-specific information.

NVGA Configures VGA for, e.g., CGA or Hercules.

PARKHD Secures the read/write heads for transport.
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PATH Sets a command search path.

PAUSE A batch processing command that causes a pause
during the processing of a batch file.

PRINT Prints files.

PROMPT Specifies the appearance of the MS-DOS
command prompt.

RECOVER Recovers a bad disk or file.

REM A batch processing command that displays a
comment in a batch file.

RENAME (REN)

Renames first file as second file.

REPLACE Replaces previous versions of files.

RESTORE Restores files backed up with the BACKUP
command.

RMDIR (RD) Removes a directory.

SELECT Installs MS-DOS with desired country-specific
information and keyboard layout.

SET Sets one string value to another in the
environment, or displays the environment.

SETUP Configures the hardware.

SHARE Installs file sharing and locking.

SHIFT A batch processing command that increases the
number of replaceable parameters in a batch
process.

SORT Sorts data forward and backward.

SUBST Substitutes a string for a path.
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SYS Transfers MS-DOS system files from one drive
to a specified drive.

TIME Displays and sets the time.

TREE Displays directory and file names.

TYPE Displays the contents of a file.

VER Prints the MS-DOS version number.

VERIFY Verifies all writes to a disk.

VOL Displays the volume label.

XCOPY Copies files and subdirectories.

XMODE Configures the CPU speed for NDC.
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Introduction

MS-DOS Shell in Brief

MS-DOS is short for Microsoft® Disk Operating System. The
operating system is actually a set of commands and programs
that control the use of the computer. In this way, the operating
system acts as an interpreter between you and your computer. It
provides such system services as diskette reads and writes, and
file management.

MS-DOS Shell is a graphic extension of MS-DOS. MS-DOS
Shell lets you take advantage of the power of MS-DOS with a
few keystrokes, or a click of a mouse. MS-DOS Shell lets you
perform many tasks: the most fundamental being the ability to
start programs and work with your files.

MS-DOS Shell saves you from excessive typing of commands.
Instead, you make selections on screens and choose commands
from menus using either the keyboard or a mouse. A menu is a
list of actions organized on your screen that you activate by
pulling down the menu and choosing the appropriate command.

The MS-DOS Shell is delivered to you in accordance with the
terms and conditions of the Nokia Licence Agreement. A copy
of the Agreement accompanies the delivery. Read the Agree-
ment carefully. It is a legal document between you and Nokia
Data.
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This Manual

This guide is intended to help both beginners and experienced
users to explore and use MS-DOS Shell.

Every Chapter begins with a short summary. By reading the
summaries first, you can already form a good idea of what
MS-DOS Shell is all about

The first two Chapters are an overview and a tutorial. They
introduce you to MS-DOS Shell gradually, progressing from
some simple, everyday tasks to more advanced features.

We recommend that you read these Chapters carefully,
especially if you are a beginner.

If you are an experienced computer user wanting to leam how
to use MS-DOS Shell, you recognize many common MS-DOS
commands. You will also find a few new ones. We recommend
that you skim through Chapters 1 and 2, perhaps working
through some of the examples.
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Other MS-DOS Manuals

Depending on how experienced a user you are, the following
manuals will also prove useful:

MS-DOS® User’s Guide

The User’s Guide has two main functions: to tell you how to
install MS-DOS, and to give you a basic understanding of
MS-DOS. If you are new at working with operating systems for
personal computers, you will want to learn a few fundamentals
before you going on to the more advanced features of MS-DOS.
This guide was written to serve that particular purpose.

MS-DOS® User’s Reference Manual

This manual provides a systematical and comprehensive
account of the features that cannot be fully treated in the User’s

Guide. These include a complete list of MS-DOS commands,
and a detailed description of EDLIN.

MS-DOS® Programmer’s Reference
Manual

This manual covers advanced technical subjects such as DOS
system calls and device drivers. If you use only application
programs (e.g. word processing), you do not need this manual.
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Notational Conventions

Throughout this manual, the following conventions are used to
distinguish elements of text:

bold Boldface indicates commands, options, switches,
and literal portions of syntax that you should
type exactly as shown.

<KEY > Angle brackets hold the name of the key you
should press.

<KEY-KEY> Angle brackets holding two or more key names
separated with a dash tell you to press the keys
simultaneously.
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We Would Like to Hear from
You!

This manual is written for you. This is why your opinions and
suggestions are very important to us. We welcome comments
on both its contents and appearance, and we would appreciate it
very much if you take the time to write them down. Please send
your comments to:

Nokia Data
Technical Writing
P.O. Box 780
SF-00101 Helsinki, Finland

Welcome to the world of MS-DOS Shell!
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Overview

Summary

This Chapter gives you an overview of Shell. For this reason,
we recommend that both beginners and experienced users study
it closely.

The first section of this Chapter gives you a listing of the
requirements needed for using Shell.

The subsequent sections describe how to start and quit Shell,
identify what you see on a screen, and what you need to know
to use Shell with a keyboard or a mouse.
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Requirements for Using Shell

To use Shell, you need the following:

• a personal computer with MS-DOS version 4.0 installed

• at least 256 kilobytes of memory; 512 kilobytes is the re-
commended amount

• a monitor

The following items are not absolutely required, but make Shell
even more useful:

• a graphics adapter card. MS-DOS Shell supports many
different graphics adapter cards.

• a serial or bus mouse

• a printer connected to your computer

If you do not have a graphics adapter installed in your system,
your screens will look somewhat different than the ones in this
guide. In particular, you will not see any grapchic icons or other
special effects on the screen.
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How Shell Helps You

Shell lets you run programs to perform specific tasks. Using the
selection cursor, you select programs from the title list of an
Shell screen. Each screen is designed to make working with
your programs easy.

Choosing Commands

You can choose commands and programs using your keyboard,
a mouse, or both together.
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The Screens of Shell

Shell contains four screens, the most fundamental of which
are the Start Programs screen and File System screen. The Start
Programs screen lets you start and organize your programs,
while File System lets you work with your directories and files.

The Start Programs Screen

This is the first screen you see when you start Shell. The Start
Programs screen also contains the Main Group of programs of
Shell. You can start programs from this screen, add or delete
programs, and change the order in which you list the programs.

07-10-88 Start Programs 9:01 am

Program Group Exit Fl=Help

Main Group
To select an item, use the up and down arrows .

To start a program or display a new group, press Enter.

| Command Prompt |

File System
Change Colors

DOS Utilities . . .

F10=Actions Shif t+F9=Command Prompt

Figure 1-1 The Start Programs screen
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The File System Screen

This screen shows you a list of all the files in your active direc-
tory. You can look at the contents of your files and print them
from the File System screen. You can also move files from one
directory to another, rename them, and delete them.

07—10—88 F i l e  System 9 :14  am 1

F i l e  Opt ions  Arrange Exi t  F l=Help

Ct r l+ le t t e r  s e l ec t s  a drive

BEI a EE]b||Zz] c [

C: \DOS
Direc to ry  Tree  * . *

O APPEND .EXE 11.113 05 -14 -88
Q ASSIGN .COM 5 .888 05 -14 -88
SI ATTRIB .EXE 18 .238 05 -14 -88
a AUTOEXEC .BAT 92 05 -14 -88
5 BACKUP .COM 33 .759 05 -14 -88
a BASIC .COM 1 .888 05 -14 -88
QBASICA .COM 36 .285 05 -14 -88
aCHKDISK .COM 17 .618 05 -14 -88
a COMMAND .COM 37 .539 05 -14 -88
a COMP .COM 9 .498 05 -14 -88
S CONFIG .SYS 148 05 -14 -88

COUNTRY .SYS 12 .861 05 -14 -88
a debug .COM 21 .613 05 -14 -88
a DISKCOMP .COM 9 .912 05 -14 -88
a DISKCOPY .COM 18 .451 05 -14 -88
£& DISPLAY .SYS 15 .756 05 -14 -88

-WINDOWS
-EXCEL
-DOS
-SUPERTEXT

L WORKS

IB§1
F 10= Act ions Shift+F9=Coinmand Prompt

Figure 1-2 The File System screen
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The Change Colors Screen

This screen lets you view up to four different color schemes and
then select the one you want to work with during your working
session.

07-10-88 9:32 amStart Programs

Fl=Help

Change Colors

To change colors use o and . Press Enter to

Sample color panels

(Esc=CancelJ ( I

"""M kJ=Enter) (Esc=Cancel) (Fl=He

y I =Enter Esc=Cancel

Figure 1-3 The Change Colors screen
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The DOS Utilities Screen

This screen shows a group of frequently used MS-DOS com-
mands available for your use. You can change the date and time
on your computer, format diskettes, and back up and restore
your files using the programs from this screen.

You can perform any MS-DOS command not accessible from
Shell from the MS-DOS command prompt and then return to
Shell as you like.

07-10-88 Start Programs 9:10 am

Program Group Exit Fl=Help

DOS Utilities...
To select an item, use the up and down arrows .

To start a program or display a new group, press Enter.

Disk Copy
Disk Compare
Backup Fixed Disk
Restore Fixed Disk

Format

F10=Actions Esc=Cancel Shift+F9=Command Prompt

Figure 1 -4 The DOS Utilities screen
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Starting Shell

When you install MS-DOS on your computer, you can have
Shell start automatically every time you turn on your computer.
You can also set Shell up so that you start it yourself from the
MS-DOS prompt.

For information about setting up Shell, see the Chapter on
installation in your MS-DOS® User’s Guide.

Starting Shell Automatically

If you have set up MS-DOS to have Shell start automatically,
just turn on your computer and the Start Programs screen
appears. If you have not set up MS-DOS to start Shell as soon
as you turn on your computer, you will see a blank screen and
the MS-DOS prompt.

Starting Shell from the Prompt

You can start Shell from the MS-DOS prompt (C:\> if Shell is
installed on your fixed disk, or A:\> if Shell is on a diskette in
drive A). At the prompt, type:

dosshell <ENTER>

The Start Programs screen appears. This screen lets you start
programs and organize them into groups.

Shell has two groups when you install it: the Main Group and
DOS Utilities. A group is a collection of related programs. For
example, you might want to organize all of your application
programs into one or more groups. You might also want to
create a group containing programs you want to protect with a
password.
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Elements of the Start Programs Screen

The screen elements have the following functions:

Menu bar

The menu bar shows the titles of the available
menus. From these menus you can choose
commands to manage programs and groups, and
to exit Shell.

Key definition line

The key definition line displays function key
information for each screen. The keys and key
combinations serve as a reminder of which
function keys perform basic operations such a
moving to the menu bar, moving to another
screen or returning to the MS-DOS command
prompt.

Selection cursor

The selection cursor shows where you are on the
screen. If you have a mouse installed, you will
also see an arrow pointer.

Title bar

The title bar displays the name of the screen. The
date and time are also displayed here.

Title list

The title list displays a list of programs and
groups. The programs listed on the Start
Programs screen make up the Main Group of
programs. Group titles are easily recognized
because they are followed by three dots.
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Stopping a Process

If you choose a command from a menu and then decide to quit
and return to your previous screen, press the <ESC> key.

In most cases, this action takes you back to your active screen -
the screen you were last working with.

For example, if you begin to delete a file and then realize you
do not want to, just press <ESC>.
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Exiting Shell

There are two ways to exit MS-DOS Shell, depending on
whether you want to use the keyboard or mouse.

Using the Keyboard

Press the <F3> key until the MS-DOS command prompt
appears.

Using the Mouse

Choose the Exit Shell command from the Exit menu on the
Start Programs screen. You will see a blank screen and the MS-
DOS prompt.
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Using the Keyboard

The following sections give you useful instructions on using
your keyboard.

Numbers or Letters, Uppercase or
Lowercase

To Shell, there is a difference between the numeral zero ( 0 )
and the capital letter O. Shell also distinguishes between the
numeral one ( 1 ) and the small letter 1.

These characters may look similar to you, but they mean
different things to the computer, so be sure you use the correct
key. Most computers display the zero on the screen with a
diagonal line through it ( 0 ).

Otherwise Shell cannot tell the difference between uppercase
and lowercase letters, so you can type commands or filenames
either way.

The keys defined in the following list let you move around on
the screen, select menus, choose commands, and get help when
you need it. The names of keys are spelled out in this guide and
appear in capital letters within angle brackets. Keynames may
be abbreviated or look different on your keyboard.
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Special Keys

The direction or arrow keys move the selection
cursor on your screen. The direction keys are the
four arrow keys on your keyboard, called
<LEFT>, <RIGHT>, <UP>, or <DOWN> in this
guide.

<ENTER> The <ENTER> key completes a command. By
pressing this key, you tell the computer to
perform a task.

<ESC> This key lets you exit from a menu to your active
screen. You can also exit most of the screens
and return to the Start Programs screen using this
key. To exit the File System screen, press the
<F3> key.

<PAGE UP> and <PAGE DOWN>

These keys move you into new screens of text in
a help information box or through a file using the
View command. For more information about the
View command, see the tutorial.

<SPACEBAR>

This key selects one or more files in the File
System screen.

<TAB> The <TAB> key lets you move around in the
File System screen and in a dialog box. For more
information about dialog boxes, see the tutorial.

<SHIFT-TAB>

This combination moves the selection cursor
backward.
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<SHDFT> Using this key with other keys increases the
actions available from your standard keyboard.
For example, “Press SHIFT+F9” means that you
should press the <SH1FT> key and hold it down
while you press and release the <F9> key. Then
release the <SHIFT> key.

<ALT-F1> This key combination displays an index of all of
the help topics in the help information box.

Function Keys

<F1> This key shows help information for any topic
you select

<F2> This key lets you save the information typed into
the text box of a dialog box. You also use this
key to copy a program to another screen.

<F3> This key displays the key assignments within a
help information box. It also switches you from
ASCII to hexadecimal format and back within
the View command.

<F4> This key creates a II mark that separates the
commands typed into the text box of a dialog
box.

<F9> This key lists the keys that you can use with the
help command within the help information box.

<F10> This key moves the selection cursor between the
menu bar and the selection area of your screen.

<F11> This key displays an index of help topics within
a help information box.
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Areas and Buttons

Along the bottom and in the upper right comer of each screen,
there is an area which provides you with different avenues to
work with or cancel commands.

For example, F1=HELP means to press <F1> to get help on any
item you have selected. If you are using a mouse, you simply
click on this area of your screen to see the help information for
the item you have selected.

In dialog boxes, these key areas appear as buttons. Press the
specified key or click the button with the mouse to activate the
function.

ENTER

This area (found primarily in dialog boxes) lets
you complete a command by pressing <ENTER>
or clicking the ENTER area with a mouse and
enters the information into the computer.

ESC=CANCEL

This area lets you cancel the action you have
selected. Click this area with a mouse or press
<ESC>.

F1=HELP

This area lets you display help information for
the item you have selected. Click this area with a
mouse or press <F1>.

F10=ACTION

This area lets you move to the menu bar to
choose a command. Click this area with a mouse
or press <F10> key.

1-17



Overview

SHIFT+F9=C0MMAND PROMPT

This area lets you exit Shell and return to the
MS-DOS command prompt Click this area with
a mouse or press <SHIFT-F9>.
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Using a Mouse

A mouse is a small, hand-held pointing device that you can use
to move around a screen, select items, and choose commands.
Moving the mouse across your desk moves a pointer on your
screen. The pointer can be either an arrow or a small rectangle.
If you are using a mouse with two or more buttons, always
press the left button when making selections.

If you run out of room on your desk while you are moving the
mouse, simply pick it up, reposition it, put it back down, and
continue with what you were doing.

The following terms are used in this guide to describe actions
with a mouse:

Click Click means to quickly press and release the
mouse button.

Drag Drag means to press the mouse button and hold
it down while moving the mouse.

Double-click Double-click means to click the mouse button
twice very quickly. If nothing happens when you
double-click the mouse on something, try
double-clicking again. Vary the time between
clicks until you find the right speed for your
mouse.

Point This action moves the mouse on your desk until
the tip of the arrow rests against the item being
described.
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Tutorial

Summary

Now that you are familiar with the basic features of Shell, you
are ready for some hands-on practice. This Chaper is a tutorial,
intended especially for beginners. However, experienced users
might also find it useful to skim through.

The exercises in this Chapter give you a thorough tour of
MS-DOS Shell. They show you how to work with screens, files,
directories, etc. The step-by-step instructions tell you exactly
what to do and what the results will be.

Each exercise is presented with keyboard instructions first and
mouse instructions second.

After working through this Chapter, you can perform many of
the tasks contained in Shell. Visit this Chapter whenever you
want to review any part of Shell basics.

If you are new to MS-DOS, study the MS-DOS® User’s Guide
to learn the fundamentals of MS-DOS.
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Starting Shell

If Shell is not already started on your computer, choose the first
or second of the following sections, depending on whether Shell
starts automatically when you turn on the computer, or whether
you have to start it separately.

Shell Starts Automatically

If Shell starts automatically, simply turn on your computer and
begin working.

Shell Does Not Start Automatically

If Shell does not start automatically, give the following
command at the MS-DOS prompt:

C:\>dosshell <ENTER>

Note If you have installed MS-DOS on diskettes, the
prompt will be A:\>.
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Starting the File System
program

Let’s begin by looking at the Start Programs screen. When you
start MS-DOS Shell, the Start Programs screen appears.

07-10-88 Start Programs 9:01 am

Program Group Exit Fl=Help

To select an
To start a program

Main Group
item, use the up and down arrows .
or display a new group, press Enter.

| Command Prompt 1
File System
Change Colors

DOS Utilities . . .

F10=Actions Shift+F9=Command Prompt

Figure 2-1 The Start Programs screen

Each program on the title list performs a different task. In this
exercise, you will start the File System program, which displays
a new screen, where you will work with files.
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Keyboard Instructions

To start the File System program using the keyboard, follow
these steps:

[7| Press the <UP> or <DOWN> keys until the selection
cursor rests on the File System program name.

[2] Press <ENTER>.

The File System screen appears.

Mouse Instructions

This is how to start the File System program using the mouse:

FH Move the mouse cursor to the File System program
name.

|~2~| Double-click the File System program name.

The File System screen appears on your screen.

Getting Help

You can get help information about any menu, option, and
command. To see how help works, follow these instructions.

Keyboard Instructions

This is how you get help using the keyboard:

FH Press <F10> to move to the menu bar. You have selected
the first menu, File.

[2] Press <F1>. You will see a help dialog box that contains
information about the File menu.
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[3] Press the direction keys to move through the help dialog
box. You can also use the <PAGE UP> or <PAGE
DOWN> keys. This action is called scrolling.

[4] Press <ESC> when you finish looking at the help infor-
mation.

You can get an index of all the topics in your help box by
pressing <F1 1> or <ALT-F1>. You can choose any topic from
this index.

Mouse Instructions

This is how to get help using the mouse:

[7| Click the File menu.

[2] Click the F1=HELP area at the top of the screen. You
will see a help dialog box that contains information
about the Open command.

[3] Click the scroll bar to move through the information
box. This is  called scrolling.

[4]  Click the ESC=CANCEL area located at the bottom of
the dialog box when you have finished reading the help
information and want to return to your active screen.
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Changing the Drive

You can change drives to perform commands on files on
another drive.

Keyboard Instructions

For example, to move to drive B on the File System screen
using the keyboard, follow these steps:

Press <TAB> to move to the drive identifiers.

Press the arrow keys to move to drive B.

Press <ENTER>.

Mouse Instructions

If  you are using a mouse, you can change drives quickly:

Fl Move to the identifier of the drive you want to use.

[2] Click the drive identifier of the drive.

0 
0 

0
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Changing the Directory

You can change directories to perform commands on files in
another directory.

For example, you can examine the files in the root directory
(C:\ for a fixed disk or A:\ for a diskette), and then change direc-
tories to look at the contents of the DOS directory.

Keyboard Instructions

This is how to change to the root directory on the File System
screen using the keyboard:

Press <TAB> to move to the directory tree.

Press the direction keys to select the root directory.

Press <ENTER>.

A mark appears to the left of the name of the root directory. The
name of the directory appears in the directory identifier.

□ 0 0

Mouse Instructions

This is how to change to the root directory on the File System
screen using the mouse:

H Move the mouse cursor to the root directory.

[2]  Click the root directory.

A mark appears to the left of the name of the root directory. The
name of the directory appears in the directory identifier.
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Returning to the Current Directory

Remember that MS-DOS sets the current directory separately
for each drive. When you change drives, the directory where
you were at that moment remains your current directory for that
drive. When you return to the drive, you come direcly back to
your current directory.

Keyboard Instructions

You can return to your current directory using the keyboard by
following these steps:

m Press the direction keys to select drive A (diskette) or
drive C (fixed disk).

|~2~| Press <ENTER>.

Mouse Instructions

You can return to your current directory using the mouse by
following these steps:

H Move to the identifier of the drive you want to use.

[2] Click the A drive identifier (diskette drive) or C drive
identifier (fixed disk drive).

You return to your current directory.
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Working with Files

This exercise shows you how to scroll through a file list, select
a file and view its contents.

Scrolling a File List

The DOS directory contains more files than can fit in the file
list. You can easily move through the iist to see all the names.

Keyboard Instructions

Scroll through the filenames on the File System screen like this:

|~T] Press the <TAB> key to move to the file list.

[2] Press the <UP> and <DOWN> arrow keys to move up
and down the list.

You can also press the <PAGE UP> and <PAGE DOWN> keys
to move quickly through large lists.

Mouse Instructions

Scroll through filenames on the File System screen like this:

Fl Move the pointer to the UP or DOWN arrows on the
scroll bar.

[2] Click the mouse.

You can use several techniques to scroll with the mouse:

• Click the single arrow in the scroll bar to move one
filename at a time.
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• Click the double arrows in the scroll bar to move one
screenful at a time.

• Drag the scroll bar to scroll through the file list in
increments of your choice.

Selecting a File

Before you can view a file or perform any other command on it,
you must select it. For instance, this is how to select the DOS-
SHELL.BAT file for viewing.

Keyboard Instructions

If  you are using the keyboard, follow these steps:

[7| Press the <TAB> key to move to the file list.

[2] Press the <UP> or <DOWN> arrows to move to the
DOSSHELL.BAT file.

r~3~| Press the <SPACEBAR>.

You have selected the DOSSHELL.BAT file.

Note Selecting a file is  a two-step process when you
are using the keyboard. First you move to the
filename, and then you press the <SPACEBAR>
to make the selection. You know the file is
selected when the greater-than sign ( > ) appears
beside the filename or when the file icon darkens.

If  you press the <SPACEBAR> again, the selection is canceled.
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Mouse Instructions

This is how to select the DOSSHELL.BAT file on the File
System screen using the mouse:

[7| Move the mouse pointer to the file named DOS-
SHELL.BAT.

[2 ]  Click the mouse.

You have selected the DOSSHELL.BAT file. If you click the
mouse again, the selection is canceled.

Viewing File Contents

You can use the View command to see the contents of a file.

Note You cannot view all files in the file list. Do not
try to view program and command files with the
extension of .EXE or .COM. If you accidentally
select one of these files for viewing, you will see
garbled text.

You can view either batch files (files with the .BAT extension),
or files that you know contain text. For example, you can view
files created with word processing applications. Text files often
have an extension such as .DOC or .TXT.

Keyboard Instructions

When the DOSSHELL.BAT file is selected, you can choose the
View command on the File System screen. Follow these steps:

FT| Press <F10> to move to the File menu.

[2] Press the underlined letter, <F>, to open the File menu.
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[3 ]  Press the underlined letter, <V>, to choose the View
command. You can also press the <DOWN> key to
move to the View command and then press <ENTER>.

The contents of the DOSSHELL.BAT file appear on your
screen.

To return to the File System screen, press <ESC>. The DOS-
SHELL.BAT file is no longer selected. Most selections are
canceled after you complete a command.

Mouse Instructions

This is how to select the View command on the File System
screen using the mouse:

Fl Click File on the menu bar.

[2] Click View.

The DOSSHELL.BAT file appears on your screen.

To return to the File System screen, click the ESC=CANCEL
area at the bottom of the screen. The DOSSHELL.BAT file is
no longer selected, and the File Systems screen reappears.
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Creating a Directory

You can use Shell to copy files from one directory to another.
If  the destination directory does not exist, you must create it
before you can copy any files into it. In this exercise, you learn
how to create a new directory, copy a file from one directory to
another, and delete a file. First, let’s create a new directory
named TEST to use in this exercise. Move to the File System
screen and create the TEST directory as follows.

Keyboard Instructions

Create a new directory using the keyboard like this:

Press the <TAB> key to move to the directory tree.

Press <ENTER> to select the C:\directory.

Press <F10> to move to the File menu.

Press the underlined letter, <F>, to open the File menu.

Press the underlined letter, <E>, to choose the Create
directory command. The dialog box appears:

Fl
 F

l 
Fl

 F
l 

Fl

Create

New directory name. .

|=Enterj I Esc=Cancel J lFl=Help

Figure 2-2 Create Directory dialog box
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|~6] Type test in the New directory name text box.

[7]  Press <ENTER>.

Your new directory, TEST, is created.

Mouse Instructions

This is how to create a new directory on the File System screen
using the mouse:

Fl1 Click the File menu.

|~2~| Click the Create directory command. A dialog box
appears.

[3] Type test in the New directory name text box.

[4] Click the ENTER area at the bottom of the dialog box.

Your new directory is created.
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Copying a File

At times, you may want to make changes to a file but keep the
original file as it is. The Copy command makes a copy of the
file while leaving the original file unchanged.

In this part of the exercise, you will copy the file named AU-
TOEXEC.BAT in the DOS directory to the TEST directory you
have created.

Keyboard Instructions

To copy the AUTOEXEC.BAT file on the File System screen
using the keyboard, follow these steps:

[l~| Press the <TAB> key to move to the directory tree.

|~2~| Press <ENTER> to select the root directory You will be
at the root of the directory tree (C:\for a fixed disk, A:\
for a diskette). The root directory now becomes the
source directory.

[3] Press the <TAB> key to move to the file list.

[4] Move to the AUTOEXEC.BAT file using the arrow
keys. Press the <SPACEBAR> to select the AUTO-
EXEC.BAT file.

[5] Press <F10> to move to the File menu. Press the under-
lined letter, <F>, to open the File menu.

|~6~| Press the <DOWN> key to choose the Copy command,
or you can simply type the underlined letter, <C>, to
choose the Copy command.
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[7] Press <ENTER>. A dialog box appears:

| Copy Fil<

AUTOEXEC.BATFrom:

To :

|=Entaxj Esc=Canc«l J Fl=H<lpJ

Figure 2-3 Copy File dialog box

f~8~| Press the <RIGHT> key to move in the text box. Type
TEST in the To: text box after the C:\ The text C:\TEST
in the text box tells MS-DOS Shell to copy the AU-
TOEXEC.BAT file to the TEST directory on the
C:\drive.

|~9~| Press <ENTER>.

You will see a message that indicates your file is being copied.
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Mouse Instructions

Follow these steps to copy the AUTOEXEC.BAT file on the
File System screen using the mouse:

Click the directory tree.

Click the AUTOEXEC.BAT file in the file list.

Click the File menu.

Click the Copy command. A dialog box appears.

Press the RIGHT key to move in the text box after the
C:\ Type test in the To: text box after the C:\

[|] The text C:\TEST in the text box tells MS-DOS Shell to
copy the AUTOEXEC.BAT file to the TEST directory
on the C:\drive.

[7] Click the ENTER area.

You will see a message that indicates your file is being copied.
E] EO ED E 

ED
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Deleting a File

The DELETE command is a powerful command. You use the
Delete command to remove a file from your computer. For
example, you might want to delete a file because the informa-
tion in it is outdated. Before using this command, be sure there
is nothing in the file you want to keep - once you delete a file,
you cannot get it back.

Keyboard Instructions

This is how to delete the duplicate copy of your AUTO-
EXEC.BAT file that you just copied to the TEST directory:

Press the <TAB> key to move to the directory tree.

Press the <DOWN> key to move to the TEST directory.

Press <ENTER> to select the TEST directory. Notice
that the AUTOEXEC.BAT file is  in the file list to the
right of the directory tree.

|~4~| Press the <TAB> key to move to the file list.

|~5~| Press the <SPACEBAR> to select the AUTO-
EXEC.BAT file. It is the only file in your TEST
directory.

|~6~| Press <F10> to move to the File menu. Press the the
underlined letter, <F>, to open the File menu.

Fl
 F

l F
l
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| 7 |  Press the underlined letter, <D>, to choose the Delete
command. A dialog box appears on the screen. AUTO-
EXEC.BAT appears in the text box, so you can confirm
what you are about to delete.

Delete File

Delete. . AUTOEXEC.BAT

=Enter] ( Esc=Cancel I [Fl=Help

Figure 2-4 Delete Item dialog box

[~8~| Press <ENTER> to delete the file. Another dialog box
appears so you can confirm the Delete command.

@ Type 2.

Notice that your directory tree looks just as it did before you
deleted the file. But the file list has changed. AUTOEXEC.BAT
is  not in the file list, and a message indicates that no files exist
in the TEST directory.

Mouse Instructions

This is how to delete the AUTOEXEC.BAT file from the TEST
directory using the mouse:

Click the TEST directory in the directory tree.

Click the AUTOEXEC.BAT file in the file list.

Click the File menu in the menu bar.0 
0 

El
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|~4~| Click the Delete command. A dialog box appears,
allowing you to confirm the file you are about to delete.

[5]  Click the ENTER area at the bottom of the dialog box.
Another dialog box appears, giving you another chance
to confirm your choice.

|~6] Click option 2.

Your directory tree looks just as it did before you deleted your
file. But the file list has changed. AUTOEXEC.BAT is not in
the file list, and a message indicates that no files exist in the
TEST directory.
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Organizing Files

You have been working with the directory tree and file list in
the last few exercises. In this exercise, you learn to change the
way your files are organized in the file list.

The file list you see when you move to the File System screen
contains all of the files in the current directory listed in alpha-
betical order. With the Display options command, you can
display a subset of the files listed in the directory and sort them
by filename, filename extension, creation date, file size, and the
disk order the files physically occupy on the disk.

Keyboard Instructions

Follow these steps to change the order of your DOS directory
file list on the File System screen:

□ On the File System screen, press the <TAB> key to mo-
ve to the directory tree.

A 
A 

A 
A Press the arrow keys to move to the DOS directory.

Press <ENTER>.

Press <F10> to select the menu bar.

Press the underlined letter, <O>, to open the Options
menu and choose the Display options command.
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[6] Press <ENTER>. The Display Options dialog box
appears.

dsp tionsF

Sort by :

0 Name
(•) |Extensior|
Q Date
Q S ize
Q Di sk  order

J=Enterj Esc=Cancel j Fl=HelpJ

Figure 2-5 Display Options box

Choosing the Sorting Options

The sorting options provide different ways for your files to be
sorted.

Press the <TAB> key to move to the first sorting option.

Press the <DOWN> key to select the Extension option.

Press <ENTER>.

Wildcards ( *.* ) indicate that all files should be listed. You can
use other wildcards and filenames (or filename extensions) to
select a specific set of files. For example, if you wanted to only
list your word processing files (files with a .DOC extension),
you would type *.doc in the Name text box. You can type your
own filenames or use wildcards to modify the files that appear
in your lists. For more information about wildcards and
filenames see the MS-DOS® User’s Guide.

R
1 P

l 
Fl
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Mouse Instructions

This is how you reorder the file list on the File System screen
using the mouse:

|~1~| On the File System screen, click the DOS directory on
the directory tree.

[2] Click the Options menu.

[3] Click the Display options command. The Display
Options dialog box appears.

[4] Click the Extension option.

[5]  Click the ENTER area at the bottom of the dialog box.

Your files are now ordered alphabetically by filename
extension.

There are many more File System functions available than are
discussed in this exercise. The Chapter on files explains all of
the options in detail.
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Working with DOS Utilities

The Start Programs screen contains the Main Group of
programs in MS-DOS Shell. DOS Utilities is one of the
members of this Main Group. When you select DOS Utilities, a
new screen appears showing you another list of programs.

Moving to the DOS Utilities Screen

To begin this exercise, move to the DOS Utilities screen.

Keyboard Instructions

To move to the DOS Utilities screen using the keyboard, do this:

[7] Press the <UP> or <DOWN> arrow keys to select the
DOS Utilities screen.

[~2~| Press <ENTER>. The DOS Utilities screen appears.

Mouse Instructions

To move to the DOS Utilities screen using the mouse, do this:

Fl Move the mouse pointer to the DOS Utilities title.

[2] Double-click the DOS Utilities tide.

The DOS Utilities screen appears.
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Formatting a Diskette

You use the Format command to prepare a diskette to hold
files and directories. Make sure you have a diskette compatible
with your drive. To check which diskettes are compatible,
consult the computer manual. FORMAT erases all information
previously stored on the diskette so be sure the diskette does not
contain any important information. Formore information about
formatting, see the MS-DOS® User’s Guide.

Keyboard Instructions

This is how to format a diskette using the keyboard:

|T| Press the <UP> or <DOWN> keys to choose the FOR-
MAT command from the DOS Utilities title list.

[2] Press <ENTER>. The Format Utility dialog box appears:

Enter drive to Format.

Parameters . .

J=Entej Esc=Cancejj [ri=Helj

Figure 2-6 Format Utility dialog box
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[3]  Press <ENTER> to format your diskette in drive A.
The DOS Utilities screen disappears and the following
message appears:

Insert new diskette for drive A:

and press ENTER when ready. . .

Insert the diskette in drive A, and press <ENTER>. The
formatting process begins.

|~4~| After the formatting is complete, a message appears:

Volume label (11 characters, ENTER for none)?

MS-DOS is prompting you to give the diskette a name
(or label). This is  an optional step. If you want to label
the diskette, type the desired name at the prompt, and
press <ENTER>.

|~5~I A message appears on the screen providing information
about the diskette, followed by:

Format another (Y/N) ?

If  you do not want to format more diskettes, press <N>
and <ENTER>.

Return to the DOS Utilities screen by pressing any key. Your
diskette is now ready to store files and directories.
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Mouse Instructions

This is how to format a diskette on the DOS Utilities screen
using the mouse:

FH Double-click the Format command on the DOS Utilities
title list.

|~2~| Click the ENTER area at the bottom of the dialog box to
format the diskette in drive A.

[3]  The DOS Utilities screen disappears and the following
message appears:

Insert new diskette for drive A:

and press ENTER when ready. . .

Insert the diskette in drive A. Press <ENTER>. The
formatting process begins.

[4]  After the formatting is complete, a message appears:

Volume label (11 characters, ENTER for none)?

MS-DOS is prompting you to give the diskette a name,
or label. This is an optional step. If you want to label the
diskette, type the desired name at the prompt, and press
<ENTER>.

|~5~| A message appears on the screen providing information
about the diskette, followed by:

Format another (Y/N) ?

If  you do not want to format another diskette, press <N>
and <ENTER>.

Return to the DOS Utilities by pressing any key on the key-
board. Your diskette is now ready to store files and directories.
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Setting the Date and Time

The date and time appear on the title bar of the Start Programs
and File System screens. You can change them easily using the
Set Date and Time command on the DOS Utilities screen.

Unless you have a clock in your system, you might want to set
the date and time each time you start your computer.

Keyboard Instructions

Follow these steps to reset the date and time with the keyboard:

|~1~| Press the <UP> or <DOWN> keys to select the Set Date
and Time command.

[2] Press <ENTER>. A dialog box appears:

| Set Date and Time Utility]

Enter new date ??-??-??

Parameters . .

:Enterl I Esc=Cancel I (Fl=Help

Figure 2-7 Setting the date

[3] To set the date to set the date to June 7, 1989, type
06-07-89 in the text box. Use the numbers 01 to 12 to
represent the month, 01 to 31 the day, and 80 to 99 the
year. Separate the numbers with a dash.
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[Z] Press <ENTER>. Another dialog box appears:

Set Date and Time

Enter new time hh:mm

Parameters . .

|=Enter) I Esc=Cancel ) IFl=Help

Figure 2-8 Setting the time

[5] To set the time to 1:15 p.m, type 13:15. Use the numbers
00 to 23 to represent the hour and 00 to 59 to represent
the minute. Separate the numbers with a colon.

|~6~| Press <ENTER>.

The DOS Utilities screen disappears and you will see the
following message on your screen:

Press any key to continue...

To return to the DOS Utilities screen, press any key on the key-
board.
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Mouse Instructions

This is how to set the date and time using the mouse:

|T» Double-click the Set Date and Time command. A dialog
box appears.

[2] Type 06-07-89 to set the date to June 7, 1989. Use the
numbers 01 to 12 to represent the month, 01 to 31 the
day, and 80 to 99 the year. Separate the numbers with a
dash.

[~3~| Click the ENTER area at the bottom of the dialog box. A
dialog box appears.

[4] Type 13:15 to set the time to 1:15 p.m. The numbers 00
to 23 represent the hour and 00 to 59 represent the
minute. Separate the numbers with a colon.

[5]  Click the ENTER area at the bottom of the dialog box.

The DOS Utilities screen disappears and you will see the
following message on your screen:

Press any key to continue...

Press any key on the keyboard to return to the DOS Utilities
screen.
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Working at the MS-DOS
Command Prompt

Shell contains many MS-DOS commands, but not all.
Occasionally, you might find it necessary to exit Shell and
perform your work at the MS-DOS command line. You can
return to Shell without disturbing any of your tasks. You can
exit Shell from all screens except the Change Colors screen.

Keyboard Instructions

For example, you might wish to scan a diskette to check it for
errors using the CHKDSK command. This is how you can
check your diskette using the keyboard:

[71 Press <SHIFT-F9>. This action is the same as choosing
the Command Prompt program from the Start Programs
title list. You see a message at the top of your screen:

When ready to return to the DOS Shell,
type EXIT then press enter.

[2]  At the prompt, type:

C:\>chkdsk <ENTER>.

MS-DOS gives you information about your total diskette space,
directories, files, and available space.

Returning to Shell

To return to the screen you were working with before
temporarily leaving MS-DOS Shell, type at the prompt:

C:\>exit <ENTER>
You return to Shell.
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Mouse Instructions

This is how you can check your diskette using the mouse:

[7| Click the SHIFT+F9=C0MMAND PROMPT area at the
bottom of the screen. This action is the same as choosing
the Command Prompt program from the Start Programs
title list.

[2] You will see a message at the top of your screen:

When ready to return to the DOS Shell,

type EXIT then press enter.

[3] At the prompt, type :

C:\>chkdsk <ENTER>.

MS-DOS gives you information about your total diskette space,
directories, files, and available space.

Returning to Shell

To return to the screen you were working with before
temporarily leaving MS-DOS Shell, type at the prompt:

C:\>exit <ENTER>.

You return to MS-DOS Shell.
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Setting Your Screen Color

You have completed this tour of Shell. There are many features
that were not covered in this chapter that you will want to
explore. But with what you have learned, you are ready to use
Shell to organize your own programs and files.

Before you move on, however, take the time to investigate one
more feature: the Change Colors command. With this com-
mand, you can adjust the colors on your computer screen. Shell
has four different color schemes to choose from. If you do not
have a graphics adapter, study the Chapter on setup options.

Keyboard Instructions

Follow these steps to select new colors using the keyboard:

|~T] Press the <UP> or <DOWN> key to select the Change
Colors program from the Start Programs title list.

[2] Press <ENTER>. A new screen appears with a display
of the colors you are currently using.

[3] Press the LEFT and RIGHT keys shown on the screen to
view the different color choices.

|~4~| Press the ENTER area at the bottom of the screen to
choose the color combination you like.

Mouse Instructions

This is how to change screen colors using the mouse:

[i] Double-click the Change Colors command. Sample
color panels appear on the screen.

[2] Click the LEFT and RIGHT keys shown on the screen to
view the different color choices.
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[3] Click the ENTER area at the bottom of the screen to
choose the color combination you like.

You will see the Start Programs screen with the color scheme
you selected.
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Exiting Shell

You can leave Shell any time you want. You have already
learned how to temporarily leave Shell and return to the same
screen you left. In this brief exercise, you will learn how to
leave the system permanently.

Keyboard Instructions

This is how to exit Shell using the keyboard:

ffl If you are at the File System screen, you must first return
to the Start Programs screen.

[2] From the Start Programs screen, you can exit Shell
easily: just pres c <F3>.

The screen is blank except for the prompt. From the prompt,
you can carry out any MS-DOS command or re-enter Shell.

Mouse Instructions

This is how to exit Shell using the mouse:

FH Click the Exit menu.

[2]  Click the Exit Shell command.

After you leave the Shell, the screen is blank except for the
MS-DOS prompt. From this prompt, you can carry out any
MS-DOS command or re-enter Shell.
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Files and Directories

Summary

This Chapter summarizes how you can work with your files and
directories under Shell. Each function has instructions and
examples to help you get the most out of Shell.

Keyboard and mouse users can follow the same instructions,
unless otherwise specified.

You should already know how to move through the screens and
make selections within them. If you are not familiar with these
basic tasks, please review the tutorial. You can always get help
while working by pressing the <F1> key.
If you are new to MS-DOS, study the MS-DOS® User’s Guide
to learn more about files, directories, and their management.
For comprehensive descriptions of all MS-DOS commands,
consult the MS-DOS® User’s Reference Manual.
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The File System Screen

The File System screen contains all the commands you need to
work with your files in fixed disk and diskette directories.
Working with the File System screen, you can rename, copy,
move, delete, and print your files. The File System screen also
lets you view the contents of files and the format of the files as
well. You can also view the contents of two directories at the
same time to compare contents.

Moving to the File System Screen

To move to the File System screen, follow the instructions in
the first or second section below, depending on whether you are
using the keyboard or a mouse.

Keyboard Instructions

To start the File System screen using the keyboard, do as
follows:

|T| Press the <UP> or <DOWN> arrows until the selection
cursor rests on the File System program name.

[2] Press <ENTER>. The File System screen appears.

Mouse Instructions

To start the File System screen using the mouse, do as follows:

|T| Move the mouse cursor to the File System program
name.

[~2~| Double-click the program name. The File System screen
appears.
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Working with Files

The following sections describe how you can work with your
files under Shell.

Selecting Files

Before you can perform commands on a file, you must select it.

Keyboard Instructions

To select a file using the keyboard, follow these steps:

FH Press the <TAB> key to move to the file list.

|~2| Search the desired file with the <UP> and <DOWN>
arrow keys.

|~3~| When the cursor lies on the desired filename, press the
<SPACEBAR>.

Mouse Instructions

If you are using a mouse, follow these steps:

Fl Move the mouse pointer to the desired filename.

j~2~| Click the mouse.
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Selecting All Files

Most Shell commands let you work with several files at once.
The Select all command from the File menu makes it easy to
select every file on the file list with one simple command. This
saves time if, for example, you want to copy or delete all of the
files in a directory. Follow these steps:

[7| Select the directory in which you want to select files.

[2] Choose the Select all command from the File menu.

All your files are selected.

Selecting Files in Different Directories

Ordinarily, any file selections you have made are automatically
canceled when you change directories. Using the Select across
directories option in the File Options dialog box in the Options
menu, you can select and work with files in more than one direc-
tory at a time.

The File Options dialog box contains three options. Two
options, Confirm on delete and Confirm on replace, are already
selected when you install Shell. The third option, Select across
directories, must be selected every time you use it.

Both the Confirm on delete and the Confirm on replace options
display a dialog box asking you to confirm the deletion or
replacement of a file or directory.

Use the Select across directories option cautiously
for deleting files if you do not want to delete all
occurrences of a file.
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To select files across directones, follow these steps:

|T| Choose the File options command from the Options
menu. A dialog box appears:

File Options

jconfirm on delete)

Confirm on replace

Select across directories□ 
IZ

I 1
3

Figure 3-1 File Options dialog box

|~2~| Move to the Select across directories option.

[3] Select the option. A mark appears beside the option to
show that it is selected. Choose the ENTER area.

The File System screen returns and you are now ready to work
with files in more than one directory.

Turning Off the Select Across Directories Option

To turn off the Select across directories option, do as follows:

Choose the File options command.

Move to the Select across directories option.

Press <SPACEB AR> or click the option with the mouse.

A 
A
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|~4~| The mark which appeared beside your filename when
you chose Select across directories is removed to show
that the file is  no longer selected.

|~5~| Choose the ENTER area.

Canceling File Selections

After selecting one or more files, you can cancel the selection
using the Deselect all command from the File menu. Any file
selections are canceled.

You can use the Deselect all command even if you only have
one or two files selected.
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Rearranging Files

Regardless of the format you are using, you can control the
way files look on the file list of the File System screen. With the
Display options command, you can limit the file display to files
that have a common name or extension, or rearrange all files
according to filename, file extension, creation date, file size, or
the order in which your files actually are stored. To limit the
files shown on a list or change their order, follow these steps:

FQ Choose the Display options command from the Options
menu. A dialog box appears:

■He.

Figure 3-2 Display Options dialog box

[2] Type the filename or extension in the name text box.
This limits the file list display by name or extension.

[3] Determine your sorting order by selecting one of the sort
options.

[4] Choose the ENTER area. The file list is rearranged. If
you are working with a multiple file list, both lists will
be rearranged.
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Moving Files

The Move command lets you move files from one location to
another. You can also rename a file during the process. Follow
these steps to move files:

H Select the file or files you want to move.

|~2~| Choose the Move command from the File menu. A dia-
log box appears, listing the file or files you selected:

| Move File |

From: | | LETTER.DOC

To: | | C:\ I±]

J=Ente E a c=Cancel J

Figure 3-3 Move File dialog box

|~3~[ Type the pathname of the directory where you want to
move the file in the To text box.

[F| Choose the ENTER area.

The files you selected are now listed in the directory you
assigned them to, and are removed from their previous
directory.

You can change the name of a file by typing a new one at the
end of the path.
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Renaming Files

Use the Rename command for changing the names of files.
With the Rename command, you could rename the file with a
more appropriate name and organize your files more effec-
tively. Follow these steps to rename files:

|~T| Select the file or files you want to rename.

|~2~| Choose the Rename command from the File menu.
A dialog box lists the current name of the first file you
selected. Because Shell lets you rename more than one
file, the status line tells you which file is  currently being
renamed.

1 o fCurrent filename: LETTER.DOC

New filename.

:Enter) I Esc=Cancel I [Fl=Help

Figure 3-4 Rename File dialog box

[3] Type the new filename in the New filename text box.

[~4~| Choose the ENTER area.

If  you selected more than one file, a dialog box appears asking
you to rename each of the files as they appear. When all of the
files are renamed, you will return to the File System screen.
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Copying Files

You can copy a file and give it a new name or create a copy in a
different directory or on another disk using the Copy command.
Follow these steps to copy files:

[71 Select the file or files you want to copy.

[2] Choose the Copy command from the File menu. A dia-
log box appears, with the filenames you selected in the
From text box.

| Copy Fil<

AUTOEXEC . BATFrom:

|=Enter) E s c=Can ce 1 J Fl=H«lpJ

Figure 3-5 Copy File dialog box

L3J Type the pathname of the directory where you want to
copy your files in the To text box.

|~4~| Choose the ENTER area.

The directory you specified now contains a copy of your file.

N ote You cannot copy files into your active directory
unless you type a new filename. MS-DOS will
not allow you to copy a file into a directory that
contains a file with the same filename.
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Deleting Files

When you do not need a file, you can delete it to make space
for other files. Note that when you delete a file, you remove it
permanently. Follow these steps to remove files:

[Tl Select the file or files you want to delete.

[2] Choose the Delete command from the File menu.
A dialog box lists the file or files you selected.

Delete  F i l e |

De le t e .  . AUTOEXEC.BAT

|=Enterj Esc=Cancel ) Fl=Halp)

Figure 3-6 Delete File dialog box

|~3~| Choose the ENTER area.

[4] A dialog box appears asking your to confirm your
actions. Choose option 2 to delete the files.

The selected files are erased permanently.
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Printing Files

If you have a printer connected to your computer, you can print
as many as 10 files at a time with the Print command:

PH Select the file or files you want to print

[~2~| Choose the Print command from the File menu.

A message indicates that your file(s) is being printed.

Opening and Starting Files

The Open command lets you start a program or file. You can
only open files with .COM, .EXE, or .BAT extensions and you
can start only one program at a time. Follow these steps:

Fl Select the file you want to open. Choose the Open
command from the File menu.

■ Open

St art ing program : AUTOEXEC . BAT

Associated file :

Options . .

J=EnterJ Esc=Cancel J Fl=Help

Figure 3-7 Open File dialog box

[2] T ype any special commands the program needs to run in
the Options text box. You can also leave the box empty.

[~3~| Choose the ENTER area.
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Associating Files with Programs

If  you use a set of files often with a particular program or appli-
cation (e.g. text files with a word processor), you can save time
with the Associate command. This command automatically
starts programs or applications whenever you open a file that
has been associated with them.

For example, all your word processing files end with the exten-
sion .DOC. You usually edit the files using a program called
EDITOR.COM. Normally, you would start EDITOR.COM,
choose a file, and begin editing. But if  you associate the .DOC
extension with the EDITOR.COM program, all you need to do
to edit any of your word processing files is  to open the file. The
associated program, EDITOR.COM, starts when you open your
document and brings it to the screen for you to edit

You could associate word processing documents with the exten-
sions .DOC, .TXT, or .LET with the same word processing
program. However, an extension can be associated with only
one program at a time. For example, you cannot associate the
extensions .DOC, .TXT, or .LET with another program after
you had assigned them to a word processing program.

You can associate one program with 20 file extensions. Each
time you open a program, the corresponding files are available
for you to access. When you open a file which has been asso-
ciated with a program, the program automatically starts and you
are ready to work with your files.

This is  how to associate files with the appropriate programs:

Fl Select the program with which you wish to associate
files.
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2 Choose the Associate command from the File menu. The
program you selected is listed in the dialog box.

| Associate F i l e |

1 ofFilename AUTOEXEC.BAT

Extensions . . [ [

:Enter] [ Esc=Cancel ] |Fl=He'

Figure 3-8 Associate File dialog box

[3] Type the filename extension (or extensions) that you
want to associate with the program you selected in the
text box. Do not type a period at the beginning of the
extension. To associate more than one extension with a
program, type the extensions in the text box, with blank
spaces between each one.

[4] Choose the ENTER area.

|~5~| Another dialog box appears, asking you whether you
would like to be prompted for options. Choose whether
or not to prompt for options by typing 1 or 2. If you
choose to prompt for options, a dialog box appears when
you open a file with one of the extensions you specified.
You can select any special parameters you might need to
run your program or application.

Note Prompting for options may not be necessary.
Check the manual of the program to learn if your
program requires any additional options to start.

3-16



Files and Directories

Disassociating Files from Programs

To disassociate a file extension from an application:

PH Select the program you want to disassociate from a file.

|~2| Choose the Associate command from the File menu. The
first program you selected is listed in the Associate File
dialog box.

|~3~| Erase the file extensions previously associated with the
program you selected.

[Z] Choose the ENTER area.
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Viewing Files

The View command lets you see the contents of a file. When
you first choose the View command, your file appears in a form
you can read: ASCII (American Standard Code for Information
Interchange). You can also view files in hexadecimal format, a
binary format programmers use. You can view only one file at a
time, and you may not change the contents of the file.

Viewing Files in ASCII Format

Follow these steps:

|T| Select the file you want to view.

|~2] Choose the View command from the File menu.

The file appears in the ASCII format.

Viewing Files in Hexadecimal Format

To view a file in the hexadecimal format:

Select the file you want to view.

Choose the View command from the File menu.

Press <F9>.

The file appears in the hexadecimal format.

El 0 0
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Showing File Information

Sometimes you may need details of a file when you are not
using the System file list command. You can get system infor-
mation quickly by using the Show information command:

0
0

Select the file you want information about.

Choose the Show information command from the
Options menu. A dialog box appears:

Show Informatio:

File
Name
Attr

Selected
Number
Size

Directory
Name
Size
Files

Disk
Name
Size
Avail
Files
Dirs

: AUTOEXEC. BAT
: . . .a

C A
: 1 8

24

: DOS
: 1.416.858

74

: JO
: 72.286.288
: 68.867.848

614
19

(Fl=Help)Esc=Cancel

Figure 3-9 Show Information dialog box
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The dialog box provides the following information:

File File information provides the filename and type
of file you have selected. The attributes are:

a archive file
r read-only file
h hidden file

You assign these attributes with the Change
attribute command.

Selected Selected information provides the number of
selected files on the current drive and their
combined total size. You may see two columns,
with the previously selected drive also
represented.

Directory Directory information provides the name, size,
and number of files in the directory you have
selected.

Disk Disk information provides the name, size,
amount of available space, and the number of
files and directories on the fixed disk or diskette
you have selected.

Assigning File Attributes

The Change attribute command lets you control three attributes
that help you manage files:

• The hidden attribute causes your file to disappear from
a directory list. For example, when you use the DIR com-
mand at the MS-DOS command prompt, the hidden files
are not visible in the listing. However, the hidden files
are displayed in the file list in the File System screen.
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• The read-only attribute protects a file by preventing it
from being changed.

• The archive attribute tells MS-DOS to make a backup
copy of a file when you use the Backup command. The
file is not backed up if you do not select this attribute.

You can change the attributes of a file by following these steps:

FH Select the file or files you want to change.

[2] Choose the Change attribute command from the File
menu. A dialog box appears:

1 . Change selected files one at a time

2. Change all selected files at once

J=Enterj Esc=Cancel J Fl-Help)

Figure 3-10 Change Attribute dialog box

|~3~| Select an option in the dialog box by typing 1 or 2.

You may select the files you want to change one at a
time or all at once.
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The Change Attribute dialog box reappears, listing your
choices:

[ Change Attribute |

File: AUTOEXEC.BAT 1 of 1

To change attribute highlight item and
press Spacebar. Press Enter when complete.

Read only
Archive

J=Enterj Esc=CancelJ (ri=Help)

Figure 3-11 Chosen Attributes

[~5~] Move to the attribute you want to change or assign.
Select it  by pressing <SPACEB AR> or clicking the
mouse. A mark appears next to the attribute to show that
it is assigned.

To remove a selection, press <SPACEBAR> again and
the arrow is removed.

|~6~| Choose the ENTER area.

Checking File Attributes

There is an easy way to check whether an attribute has been
assigned.

Use the Show information command for the desired file.
A selected attribute will be indicated by a lowercase letter in the
file.
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Working with Directories

A directory is like a file drawer you can store files in. Sub-
directories can be added to help organize your files, like
dividers in the file drawer.

The File System screen contains all the commands that let
you manage directories. Just as you can choose commands to
manage files, you can also use commands on the File menu to
manage directories. This makes it easy to create new directories
and rename or delete existing ones.

Notice that most of the things you can do with directories, such
as delete or rename, can also be done with subdirectories. All
you need to do to perform these commands on subdirectories is
to select the subdirectory before you choose a command.
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Viewing Two Directories
Simultaneously

When you first move to the File System screen, the files are in
a single file list You can view and compare the contents of
two directories by choosing the Multiple file list command from
the Arrange Menu. This is what the screen looks like when it
displays two directory trees and file listings:

1 07—10—88 F i l e  System 9 :41  am

Fi l e  Options Arrange Exit  Fl=Help
Ctr l+le t ter  se lec t s  a drive

® a [&]  b | [Zz]c |

C : \DOS
Directory  Tree * . *

C : \ □ S DISKCOPY .COM 18 .451 05-14 -88
-WINDOWS DISPLAY .SYS 15 .756 05-14 -88
-EXCEL O DOSSHELL .BAT 216 06-09 -88
-DOS I DOSUTIL .MEU 9.768 06-09 -88
-SUPERTEXT 1 DRIVER .SYS 5 .289 05-14 -88

L WORKS 4

Direc tory  Tree

3

S MLSFUNC .EXE 6 .878 07-07 -88
PCIBMDRV .MOS 263 07-07 -88

1 P CMS DRV .MOS 927 07-07 -88
PCMSPDRV .MOS 765 07-07 -88

O PRINT .COM 14 .131 07-07 -88

2

¥
¥

F10=Actions Shift +F9=Conimand Prompt

Figure 3-12 Displaying two directories

All File System screen commands and functions can be
performed after choosing the Multiple file list command.
You can change either directory to compare listings, and you
can work with multiple files. If you have chosen the Select
across directories option, you can work with multiple files in
two directories.
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Viewing the System File List

The System file shows you all files in all directories plus a
summary list of system information. Choose the System file list
command from the Arrange menu. The System file list appears:

07—10—88 F i l e  System 9 :14  am 1
Fi l e  Options Arrange Exi t  Fl=Help
Ctr l+ le t te r  se lec ts  a drive

E§11 A lai b|cZ] c [
C: \DOS

Direc to ry  Tree  * .*

< □ts a APPEND
a ASSIGN
G3 ATTRIB
a AUTOEXEC
a BACKUP
a BASIC
SBASICA
aCHKDISK
a COMMAND
a COMP
a CONFIG

COUNTRY
a DEBUG
a DISKCOMP
a DISKCOPY
€& DISPLAY

.EXE

.COM
.EXE
.BAT
.COM
.COM
.COM
.COM
.COM
.COM
.SYS
.SYS
.COM
.COM
.COM
.SYS

11 .113
5 .888

18 .238
92

33 .759
1 .888

36 .285
17 .618
37 .539

9 .498
148

12 .861
21 .613

9 .912
18 .451
15 . 756

O
O

C
O

O
O

O
O

O
O

O
O

O
O

C
O
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V
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-SUPERTEXT
L WORKS
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g
F10=Actions Shift+F9=Command Prompt

Figure 3-13 The System file list

Using the System file list command, you can view all of your
files regardless of which directories they are in.

3-25



Files and Directories

The system file list provides the following information:

File File information provides the filename and type
of file you have selected. The type attributes are:

a archive
r read-only
h hidden file

You assign these attributes with the Change
attribute command.

Selected Selected information provides the number of
selected files on the working disk or diskette and
their combined total size. You may see two
columns, with the previously selected drive also
represented.

Directory Directory information provides the name, size,
and number of files in the directory you have
selected.

Disk Disk information provides the name, size,
amount of available space, and the number of
files and directories on the fixed disk or diskette
you have selected.

Returning to a Single File List

After viewing your files and directories in different configura-
tions and formats, you can return to the standard single file list
format to perform additional work with your files.

To return to the single file list, choose the Single file list
command from the Arrange menu. The single file list appears.

3-26



Files and Directories

Creating a Directory

Before you can place files in a directory, you must create one.
You will see the new directory as it appears on the directory
tree. You can add directories at any level in the tree. Follow
these steps:

PI Move to the File System screen.

|~2~| Select the root directory (C or A) at the top of the
directory tree.

[3]  Choose the Create directory command from the File
menu. You will see a dialog box:

Create Directory!

New directory name. .

|=Enterj I Esc=Cancel j [Fl=Help

Figure 3-14 Create Directory dialog box

|~4~| Type the name of the new directory in the text box. A
name can be up to eight characters long and you may
add a three-character extension.

|~5~| Choose the ENTER area.
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Renaming a Directory

To change the name of a directory or subdirectory, do this:

R1 Choose the Deselect all command from the File menu if
any files are selected.

|~2~| Select the directory you want to rename.

[3] Choose the Rename command from the File menu. A
dialog box appears:

l Re 
name

Current name : TEST

New name

=Enter Esc=Cancel Fl=Help

Figure 3-15 Rename Directory dialog box

[4]  T ype the new name for the directory in the text box.

[~5~| Choose the ENTER area.

Your directory name changes in the directory tree.
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Removing a Directory

To delete a directory, you must first delete the files and sub-
directories contained in the directory. Follow these steps:

Delete any files which may still be in the directory.

Select the directory.

Choose the Delete command from the File menu. A dia-
log box appears:

El El El

Directory: C:\TEST

Select an option.

Do not delete this directory

2 . Delete this directory

J=Enterj Esc=Cancel j Fl=Help)

Figure 3-16 Delete Directory dialog box

[4] Type 2 to choose option 2 and delete the directory.

Your directory is  deleted from the directory tree.
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Copying a Directory

It is easy to duplicate a directory. Follow these steps to copy a
directory:

Fl Select the disk drive or the directory to which you want
to copy.

Create a new directory.

Select the directory you want to copy.

Choose the Select all command from the File menu to
select all the files in the directory.

|~5~| Choose the Copy command on the File menu to copy the
files. A dialog box appears.

|~6| Type the path of your new directory in the To: text box,
including the drive name if the directory is on a different
drive.

Fl Choose the ENTER area.

If  you want to duplicate a directory that has several sub-
directories, create a new directory first, then add the new sub-
directories to it. Once the structure is complete, you may then
copy files from each of the source directories to each of the new
directories.

R
1 R

1 F
*1

3-30



Working with
Diskettes and Fixed
Disks

Contents

4-3 Summary
4-4 The DOS Utilities Screen
4-5 Formatting Diskettes
4-7 Copying Diskettes
4-9 Comparing Two Diskettes

4-11 Backing Up Fixed Disks
to Diskettes

4-13 Restoring Files from
Diskettes to Fixed Disks





Diskettes and Fixed Disk

Summary

This Chapter summarizes comprehensively how you can work
with your diskettes and fixed disks under MS-DOS Shell. Each
function has instructions and examples to help you get the most
out of Shell. Keyboard and mouse users can follow the same
instructions, unless otherwise specified.

You should already know how to move through the screens and
make selections within them. If you are not familiar with these
basic tasks, please review the tutorial. You can always get help
while working by pressing the <F1> key.

If you are new to MS-DOS, study the MS-DOS® User’s Guide
to leam more about using diskettes. For descriptions of all
MS-DOS commands, consult the MS-DOS® User’s Reference
Manual.
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The DOS Utilities Screen

The DOS Utilities group on the Start Programs screen contains
all the commands that let you manage your diskettes and fixed
disks. To move to the DOS Utilities screen, choose the DOS
Utilities command. The screen appears:

07-10-88 Start Programs 9:10 am

Program Group Exit Fl=Help

DOS Utilities . . .
To select an item, use the up

To start a program or display a new
and down arrows .
group, press Enter.

Set Date and Time 1
Disk Copy
Disk Compare
Backup Fixed Disk
Restore Fixed Disk

Format

F10=Actions Esc=Cancel Shif t+F9=Command Prompt

Figure 4-1 DOS Utilities screen

From the DOS Utilities screen, you can

• prepare diskettes to receive information,

• copy information from one diskette to another,

• compare the contents of two diskettes,

• back up files from fixed disks to diskettes,

• restore backed-up files from diskettes to fixed disks.
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Formatting Diskettes

To format a diskette under MS-DOS Shell, you can use the
Format command from the DOS Utilities screen, as follows:

|"T| Choose the Format command. A dialog box appears:

| Format Utility)

Enter drive to Format.

Parameters . . | [a :

J=Ente Esc=Cancel) Fl=Hel

Figure 4-2 Format Utility dialog box

[2] Type the letter of the drive that contains the diskette to
be formatted. By default, drive A will appear in the
Format Utility dialog box.

[3] Choose the ENTER area. The DOS Utilities screen
retreats, and the following message will be displayed:

Insert new diskette for drive A:

and press ENTER when ready.

[4]  Insert the diskette in drive A and press <ENTER>. The
formatting process begins.
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|~5~| After the formatting is complete, the following message
will be displayed:

Volume label (11 characters, ENTER for none)?

MS-DOS is prompting you to give the diskette a name (a
label). Labeling is  an optional but a most useful step. If
you want to label the diskette, type the desired name at
the prompt and press <ENTER>. If you do not want to
label the diskette, just press <ENTER>.

|~6] A message giving information on the diskette will be
displayed, followed by the question:

Format another (Y/N) ?

Your diskette is now ready to receive information. If you
want to continue formatting, press <Y> and <ENTER>.
If you do not want continue formatting, press <N> and
<ENTER>.

To return to the DOS Utilities screen, press any key. The screen
is displayed.

You can use switches to make the Format command more
powerful. These switches are described in the MS-DOS®
User’s Reference Manual.
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Copying Diskettes

You can copy the contents of a diskette to another using the
Diskcopy command. If you want to copy the contents of a fixed
disk, you must use the Backup Fixed Disk command which is
described later in this Chapter.

If  you use an unformatted diskette as the target diskette, the
Diskcopy command will format it while copying. If you are
going to use a formatted diskette as the target diskette, make
sure that it does not contain anything that you do not actually
want to destroy.

To copy a diskette to another, follow these steps:

FH Choose the Diskcopy command from the DOS Utilities
screen. A dialog box appears:

Enter source and destination drives.

Drives

J=Enterj Esc=Cancel j Fl=Help

Figure 4-3 Diskcopy Utility dialog box

[2]  The Diskcopy command copies the contents of the
diskette in the source drive to the diskette in the destina-
tion drive. Type the letters of the source and destination
drives. Include the colon ( : ) after each drive letter.
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[3] Choose the ENTER area. The DOS Utilities screen
retreats, and the following message will be displayed:

Insert SOURCE diskette in drive A:

Press any key to continue...

0 Insert the diskette to be copied, and press any key to
continue the process.

|~5~| As MS-DOS copies the contents of the source diskette, it
displays a message informing you on the status of the
process. After the contents of the source diskette are
copied, the following message will be displayed:

Insert TARGET diskette in drive B:

Press any key to continue...

|~6~| Insert the diskette to which you want to copy the
information, and press any key to continue the process.

[7] When the copy process is  complete, the following
message will be displayed:

Copy another diskette (Y/N) ?

If  you want to copy more diskettes, press <Y> and <EN-
TER>. If you want to stop copying, press <N> and <EN-
TER>. If you continue, Shell prompts you for the source
and target diskettes, and performs the next copy on the
drives that you originally specified.

To return to the DOS Utilities screen, press any key.

Now you have an identical copy of your original diskette.
After copying a diskette, it is a good idea to compare the target
diskette with the source diskette to make sure that nothing is
missing.
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Comparing Two Diskettes

You can check that two diskettes contain identical information
by using the Disk Compare command from the DOS Utilities
screen. Disk Compare is useful when you have copied a diskette
with the Diskcopy command, and you want to ensure that the
target diskette is an exact copy of the source diskette. Follow
these steps:

Fl Choose the Disk Compare command from the DOS Utili-
ties group. A dialog box appears:

Diskcomp

Enter drive for comparison.

b:Parameters . .

Enter) I Esc=Cancel J |F1 :

Figure 4-4 Diskcomp UtUity dialog box

[2] Type the drive letters in the text box.
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[5] Choose the ENTER area. The DOS Utilities screen
retreats while the comparison is in progress. The
following message is displayed:

Insert FIRST diskette in drive A:

Insert SECOND diskette in drive B:

Press any key to continue. . .

[4] Insert the diskettes you want to compare in the specified
drives, and press any key to continue the process.

|~5~| As MS-DOS reads the contents of the diskettes, it
displays a message informing you on the status of the
process. If the diskettes are identical, the following
message is displayed:

Compare OK

|~6~| When the comparison is completed, the following
message is displayed:

Compare another diskette (Y/N) ?

If you want to continue comparing diskettes, press <Y>
and follow the instructions displayed on the screen.

If you want to stop comparing, press <N>.

To return to the DOS Utilities screen, press any key.
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Backing Up Fixed Disks to
Diskettes

You can easily copy files from a fixed disk to diskettes using
the Backup Fixed Disk command. Backing up is a more power-
ful process than copying. It destroys andy existing information
on your diskettes before the backup information is  copied onto
them.

Back up you fixed disk as often as you feel necessary to protect
the information stored in your computer. Depending on the
amount of information stored, you may need several diskettes.

Note You can only use the Backup Fixed Disk and
Restore Fixed Disk commands if you have
MS-DOS Shell installed on a fixed disk.

Follow these steps:

[*i] Choose the Backup Fixed Disk command from the DOS
Utilities screen. A dialog box appears:

| Backup Utility |

Enter source and destination drives.

Parameters . .

J=Enterj ( Esc=Cancel J Fl=Help J

Figure 4-5 Backup Utility dialog box
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[~2~] Type the drive letter and the path name of the source
files and the destination drive name. Include any
switches you want to use.

[3] Choose the ENTER area. The following warning will be
displayed:

Insert backup diskette in drive A:

WARNING! Files in the target drive will be

erased .

Press any key to continue. . .

[4]  Insert the backup diskette in the specified drive, and
press any key to continue the process.

|~5~| The Backup Fixed Disk command formats the diskette in
the diskette drive before it  transfers files to the diskette.
After the formatting is complete, the following message
will be displayed:

Press any key to continue. . .

Press any key to begin transferring the files.

[~6~| MS-DOS lists the files being backed up on the screen.
After all files are transferred to the diskette, the follo-
wing message will be displayed:

Press any key to continue. . .

To return to the DOS Utilities screen, press any key. You
can make the Backup command even more powerful using
switches. These switches are described in the MS-DOS® User’s
Reference Manual.
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Restoring Files from
Diskettes to Fixed Disks

To return files backed up with the Backup Fixed Disk com-
mand, you must use the Restore Fixed Disk command.

Note You can only use the Backup Fixed Disk and
Restore Fixed Disk commands if you have
MS-DOS Shell installed on a fixed disk.

Follow these steps:

Choose the Restore Fixed Disk command from the DOS
Utilities screen. A dialog box appears:

[Restore Utility |

Enter source and destination drive.

Parameters . j |*: c:\*.* /s [-►

J=Enterj Esc=Cancel J Fl=Helpj

Figure 4-6 Restore Utility dialog box

[2]  T ype the drive letters for the source and destination
drives.
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|~3~| Choose the ENTER area. The following message will be
displayed:

Insert backup diskette in drive A:

Press any key to continue. . .

[4] Insert the backup diskette in the specified drive, and
press any key to begin the restoration process.

[5]  Shell lists the files being restored to the fixed disk on the
screen. After the restoration is completed, the following
message will be displayed:

Press any key to continue. . .

To return to the DOS Utilities screen, press any key.
When the restoration process is completed, the files you backed
up are returned to the fixed disk you specified.
You can make the Restore command more flexible with
switches. These switches are described in the MS-DOS® User’s
Reference Manual.
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Groups

Summary

This Chapter summarizes comprehensively how you can work
with groups under MS-DOS Shell. A group is a collection of
related programs. When you install Shell, it contains two
groups: the Main Group and DOS Utilities. You regocnize a
group from the three dots following the title of the group.

You can create groups, and make changes to them.

If you need more information about the specific tasks, you can
always press <F1> to get help while you are working.

If you are new to MS-DOS, study the MS-DOS® User’s Guide
to learn the basics about MS-DOS. For descriptions of all MS-
DOS commands, consult the MS-DOS® User’s Reference
Manual.
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Groups

A group is a collection of related programs. When you install
MS-DOS Shell, it contains two groups: the Main Group and
DOS Utilities. You can always recognize a group from the three
dots after the group title.

You will probably want to organize your programs into groups.
If you put all your programs on the Start Programs screen, it
would be difficult to find them easily. Adding groups to Shell
gives you a way to organize your program files.

For example, you can put similar programs into one group
with a general name, like Account On your Account screen,
you would add all the programs you use to perform accounting
functions, such as a program to maintain your checkbook or
estimate taxes. You might want to create a group of programs
that you want to protect with a password.

Each group can contain up to 16 programs.
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Adding a Group

You can add a group only to the Main Group list on the Start
Programs screen. The Start Programs screen contains all of the
commands that let you manage groups.

You may give a group any title you like and assign a password
to limit access to the group. You can also type help text when
you create the new group.

This is how to add a group to the Main Group list:

|T| Move to the Main Group list on the Start Programs
screen.

|~2~| Choose the Add command from the Group menu. A
dialog box appears:

| Add Group |

Required

Title

Commands

Optional

Help text

Password

Figure 5-1 Add Group dialog box
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[3] Type the title for the new group in the Title text box.
Titles appear on the group list exactly as you type them
in this text box. A title may not contain more than 37
characters, including blank spaces.

|~4~| Move to the Filename text box.

|~5~| Type a name for your new group. Your filename can
contain up to eight characters. Do not use an extension:
the file is automatically appended with the extension
.MEU.

|~6~| Before saving the changes by pressing <F2>, you can
add help information, or assign a password to protect the
group. These steps are described in the following two
sections. If you want just save the information, press
<F2>.

The group title is added to the group list.

Note You cannot save your information unless you
have provided all the required information: that
is, filled in the Title and Filename text boxes.
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Adding Help Information

Using help texts is  optional. If you want to add help informa-
tion, follow these steps:

|~1~| Move to the Help text box.

[2]  Type the desired information. You can use up to 478
characters, including blank spaces. Help text appears just
as you type it, with upper and lowercase letters and
blank spaces. It is automatically formatted to fit in the
Help text box but, if you want to break a line to begin a
new paragraph, just type an ampersand (&) at the new
line. Now when you press <F1>, you will see Help
information for this group.

Using a Password

If  you want to protect a group with a password, do as follows:

Fl Move to the Password text box.

[2] T ype the password. It can include up to eight characters,
including blank spaces. If  you do not want to assign a
password, leave this field blank.
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Changing a Group

After a group title is added to the Main Group list, you can
change the tide, filename, password, or help text.

To change a group, follow these steps:

Select the group you wish to change from the tide list.

Choose the Change command from the Group menu.

If you assigned a password when you added the group,
the Password dialog box appears. Type your password.

[4]  Choose the ENTER area. The Change Group dialog box
appears:

El E3 0

Required

Title Word Processing

Commands WORD

Optional.

Help text

Paaaword

EacaCancel J Fl-Help J (F2-Save

Figure 5-2 Change Group dialog box

[5]  Type the changes in the appropriate text box.
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|~6] Press <F2> to save your changes.

The Main Group screen appears.

Note You cannot save your changes unless you have
provided all the required information: that is,
filled in the Title and Filename text fields.
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Deleting a Group

When you want to free your screen of groups that you no longer
need, you can delete a group. Remember that when you delete a
group, you delete all programs listed within it. Deleting a group
from the Start Programs screen does not delete the programs
from your computer. To remove a group and all of the programs
contained in it, follow these steps:

FH Select the group from the title list.

[2] Choose the Delete command from the Group menu.

[3] If you assigned a password when you added the group,
the Password dialog box appears. Type your password.

[4] A dialog box appears:

Delate Item

|1. Delete this item |

2 . Do not delete this item

) (Fl=Halp ]J Esc=Cancel

5-5 Delete Item dialog box

[~5~| Choose option 1 to delete your group.

The group is removed from the title list. Any program titles you
may have assigned to the group are deleted from Shell.
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Rearranging Group Titles

You can rearrange the order of program and group titles on the
Start Programs and DOS Utilities screens. You can also re-
arrange the title list of a group you have created. Follow these
steps:

Select the title you want to reposition.

Choose the Reorder command from the Group menu.

The message at the top of your screen gives you
directions for the rearranging process.

A 
Fl

To complete the reorder, highlight the

new position, then press <ENTER> .

Press <ESC> to cancel.

[~4~| Move the selection cursor to where you want the title to
move.

[5] Press <ENTER>.

Your title is now repositioned on the list.
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Applications

Summary

This Chapter summarizes comprehensively how you can work
with your applications under MS-DOS Shell.

Each function has instructions and examples to help you get
the most out of MS-DOS Shell. Keyboard and mouse users can
follow the same instructions, unless otherwise specified. You
should already know how to move through screens and make
selections within them. If you do not, please review the tutorial.
You can always get help while you are working by pressing the
<F1> key.

If you are new to MS-DOS, study the MS-DOS® User’s Guide
to learn more about the operating system. For information about
MS-DOS commands, see the MS-DOS® User’s Reference
Manual.
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Working with Application
Programs

You have great flexibility in managing the programs you work
with frequently. You can simply add the programs and applica-
tions to a group and then select the program from the title list on
the new group screen.

A group leads you to another screen where you will see a list of
programs. You can always recognize a group name from the
three small dots that follow the group title.

The Start Programs screen contains all of the commands that let
you manage programs.

When you add a program, application, or group to a group list,
you can give it any name you want. Starting a program then
consists of selecting the name from the group list and comple-
ting the command, using either your keyboard or a mouse. The
program starts right away. You do not need to look through
directories or type complicated paths and filenames.

6-4



Applications

Adding a Program

You can add programs to the Start Programs or DOS Utilities
screens. The title may represent an application, an individual
program, or the title of a group.

You can add any program you like, write your own help text,
and create a password to limit access to the program.

To add a program to the Start Programs or DOS Utilities
screens, follow these steps:

Move to the screen where you want to add the program.

Choose the Add command from the Program menu.

You will see the Add Program dialog box on your screen:

E] 0 
0

I Add Programl

Required

ETitle

Conmands

Optional

Help text . .

Password

Esc*Cancel J [Fl-Help J [F2-Save

Figure 6-1 Add Program dialog box
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[4] Type the title you want to appear on the screen in the
Title text box. Titles may be 40 characters long,
including blank spaces.

[5] Move to the Commands text box.

|~6~| Type the same command string you would ordinarily
type from the root directory if you were starting the
program there. When multiple commands are required,
press <F4> at the end of each command.

[7] Before saving the changes, you can add your own help
information and assign a password. This is described in
the following two sections. If you want just save the
changes, press <F2>. Your program is added to the title
list.

Example

Suppose you have a word processing program named SUPER-
TEXT which you usually start by typing super, this is where
you would type the command. But if SUPERTEXT is in a direc-
tory called SUPERTXT on drive C, you would type:

c:| |cd\supertxt| (super

The three commands tell MS-DOS Shell to go to drive C,  to
change to the directory SUPERTXT, and to start the word
processing program called SUPERTEXT.

Note The <F4> key inserts the 1 1 marker that separates
the parts of the command.
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Adding Help Information

If  you want to add help information, follow these steps:

Fl Move to the Help text box.

[2] Type your help information. It appears when you press
<F1> or click the F1=HELP area. The help information
you type appears on the screen exactly as you type it (up
to 478 characters), with uppercase and lowercase letters
and blank spaces. It is automatically formatted to fit in
the Help text box unless you type an ampersand (&) to
force a new line in the help text box.

Using a Password

A password is not necessary to start a program. If you want to
protect a program with a password, follow these steps:

Fl Move to the Password text box.

[~2~] T ype the password. It can include up to eight characters,
including blank spaces.

|~3~] If you decide to assign a password to a program, be sure
to make a note and keep it in a safe place. There is  no
way to find out a password once it has been typed, and
you will need it in order to use, change, or delete the
program.

[4] Press <F2> to save your information.

Your program title is added to the title list.
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Changing a Program

After you add a program title to a title list, you can change the
name of the program, the command that starts the program, any
help text, or your password. To change a program, follow these
steps:

fil Select the program on the title list

|~2~| Choose the Change command from the Program menu.

If  you assigned a password to the program, the Password
dialog box appears:

Password

Type password then press
Enter

Password

Esc=Cancel I lFl=HelpEnter

Figure 6-2 Password dialog box

[3] T ype your password.

|~4~| Choose the ENTER area.
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□ The Change Program dialog box appears:

Required

Title . .

Commands

Optional

Help text

Password

| |word Processing (-►I

1 lWord |->|

Figure 6-3 Change Program dialog box

|~6] Type any new information into the text boxes.

[7] Press <F2> to save your changes.

Your changes are saved and you see the title list again.

Note You cannot save your changes unless you have
provided all the required information: that is,
filled in the Title and Commands text boxes.
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Deleting a Program Title

You may delete a program, application, or title from any title
list. Use the Delete command from the Program menu on either
the Start Programs or DOS Utilities screens. Deleting a program
name from a title list does not delete the program from your
computer.

To delete a program from a title list, follow these steps:

Select the program title you want to delete.

Choose the Delete command from the Program menu.

If  you assigned a password when you added the
program, the Password dialog box appears. Type your
password.

|~4~| Choose the ENTER area. The Delete Item dialog box
appears:

0 
0 

0

Delete Item

Delete this item

Do not delete this item

=Enter ] [ Esc=Cancel Fl=Help

Figure 6-4 Delete Item dialog box

|~5~| Select an option in the dialog box by typing 1 or 2.

The program title is removed from the title list but the program
is not deleted from your computer.
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Copying a Program

You can copy a program to as many groups as you like. The
title, the command that starts the program, help text, and pass-
word, if any, are included when you copy the program.

To copy a program from one screen to another, follow these
steps:

Pl
 P

l 
Pl Select the program title you want to copy.

Choose the Copy command from the Program menu.

If you assigned a password when you added the
program, the Password dialog box appears. Type your
password.

[~4~| Choose the ENTER area.

[5]  The message at the top of your screen gives you
directions for the copy process:

To complete the copy, display the

destination group, then press F2 .
Press F3 to cancel copy.

Move to the screen that contains the group you want to
copy your program to.

|~6~| Press <F2> to complete the process.

The program is copied to the new group and you can start it
from either title list.
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Starting a Program

You can easily start a program from a title list. Follow these
steps:

Select the program title.

Press <ENTER>.

If you are using a mouse, double-click the program
name.

The program begins automatically. Exit the program as you
would normally. You will return to MS-DOS Shell to resume
your work.

[«
] E

l E
l
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Customizing Applications

Shell offers several features to make it more convenient to
start and use your application programs. You can create and
display a custom dialog box to prompt for a filename or
program options before starting the program; you can carry
out MS-DOS commands prior to starting the program or
immediately after exiting from it; and you can install menus that
have been provided with your application programs.

Creating and Displaying a Dialog Box

When you create a custom dialog box for one of your appli-
cation programs, that dialog box is  displayed for you to fill in
the requested information each time you start the program. For
example, if you add a word processor to a group, you can have
Shell automatically prompt you for the name of the file to edit
each time you start the word processor. You control the title and
prompt text for this dialog box and, to some extent, the informa-
tion can be typed into the text box.

You create custom dialog boxes with the Add or Change com-
mand from the program menu. Whenever you add a program,
you supply the commands necessary to start the program in the
Commands text box. To define a dialog box, you type one or
more startup options, enclosed in brackets, after those
commands.
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Example

To start an imaginary word processing program called SUPER-
TEXT with any of the startup options, you would enter the
following command line, with the desired options inside the
brackets:

c:| |cd\supertxt| |super [startup options]

The double vertical line is inserted by pressing the <F4> key.
You use it to separate commands in the command line, but you
cannot use it before the bracketed commands or between startup
options.

Options for Dialog Boxes

The startup options you can use to define a dialog box are
described in the following list. Combine the options you want
for a particular dialog box within a single set of brackets. The
maximum length of the command line is 500 characters.

[ ] The “empty brackets” option displays a dialog
box with standard instructions and prompts.

/T" title name"

This option displays a dialog box that prompts
for a filename or other program input. The title
name appears at the top of the dialog box.

/I" instructions"

This option displays the instructions in the dialog
box. You can enter up to 40 characters of text.

/P" prompt"

This option displays the prompt next to the text
box of your customized dialog box. You can
enter up to 20 characters.
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% n This option defines the value entered in the
dialog box as a variable with name n. You can
define up to 10 variables for each program.

/D" default"

This option displays the default value in the
dialog box.

ZD" %n" This option displays the value for the variable n
as the default value.

/R This option clears the default value from the
dialog box as soon as you press a key.

ZL"n" This option limits the number of characters you
can type into the dialog box. Valid values for n
are between 1 and 128.

ZM"E" This option lets you enter only existing
filenames in the dialog box.

/C" %n" This option saves the information defined as
variable n to be used the next time the program is
started. For example, using this option you could
return automatically to the file you were last
editing.

Let’s look at a few sample command lines to see how these
options work.
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Example 1

You have a word processing program called SUPERTEXT in a
directory named SUPERTXT. You want to have a command
line that changes to the SUPERTXT directory, starts the
SUPERTEXT program, and displays a dialog box titled File-
name with the following instructions and prompt:

Type name of file to edit
Filename

The correct command line would look like this:

cd \supertxt||super [/T" Filename”/!" Type name of
file to edit" ZP" Filename”]

Example 2

Like Example 1 , but you also want to have the filename
LETTER.DOC displayed on the screen as the default value.
The correct command line would look like this:

cd \supertxt||super [/T" Filename"/!" Type name of
file to edit"/P”Filename"/D"letter.doc"]

Example 3

You need a command line that starts SUPERTEXT, displays
the dialog box prompting for the filename, and stores the en-
tered filename as a variable, so that the next time you start
SUPERTEXT, the stored filename is displayed as the default
value in the text box. The correct syntax would look like this:

cd\supertxt||super [%l/T"Filename"/I" Type name
of file to edit"/P”Filename"/C" %1"/D" %1"/R]

The /R at the end of the command line causes the default value
to be erased as soon as you press any key except <ENTER>.
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Using Additional Options

There are also other options for providing additional infor-
mation to your program. These options are typed at the end of
the command line, outside of the brackets used to display a
dialog box.

Before entering the first option and between each option
you must press <F4>.

The available options are described in the following list:

This option refers to the variable named n. Use
this option in conjunction with another
command, such as PRINT.

%n

/# This option substitutes the drive from which
Shell was started for this symbol in the command
line.

/@ This option substitutes the path from which Shell
was started for this symbol in the command line.
Do not enter a backslash character before this
symbol.
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Executing MS-DOS Commands

You can use any MS-DOS command in the command line that
you use for starting your program. You can include MS-DOS
commands anywhere in the command line, as long as they are
outside the brackets used to define a dialog box. Separate
commands with a double vertical line by pressing <F4>.

The following list shows some of the MS-DOS commands you
might find helpful:

print %n This command prints the file referred to by the
variable n. The command line would look
something like this:

super [%l/T"Filename"/I" Type name of file
to edit" /P" Filename"] | Iprint %1

type % n This command displays the contents of the file
referenced by the variable n.

pause When you exit from the application program, the
Shell Start Programs screen appears at once. If
any MS-DOS messages are displayed as you exit
from the program, they are not visible. Including
the Pause command in your command line you
can stop before redisplaying the Start Programs
screen. When you exit from the program, the
process will stop while you read any displayed
messages. When you are ready, you can return to
the Start Programs screen by pressing any key.
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Using Batch Files

You may prefer entering the commands necessary to set up
and start your application program in a batch file, especially if
several commands are required. You can then call that batch file
from the command line, and Shell executes the commands in
the batch file whenever you start the program. (A batch file is
an ASCII text file that contains a series of MS-DOS commands,
each on a separate line. All batch files must have the extension
.BAT.)

Example

Suppose you have a batch file named SUPER.BAT with all
the commands necessary to change directories and start an
imaginary word processing program called SUPERTEXT. The
batch file contents would be something like this:

cd \supertxt
super

To carry out this batch file whenever you start SUPERTEXT,
you would enter the following in the command line:

call super.bat

You cannot include any options, including the bracketed
commands to display a dialog box, in the batch file. If you want
to use these options, they must be typed on the command line.
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Setup Options

Summary

MS-DOS Shell is made up of several programs. Once you
install MS-DOS Shell on your computer, you can view it and
change it according to your needs.

The way MS-DOS Shell works is determined by the contents of
the DOSSHELL.BAT file. This Chapter describes the various
options that can be included in this file.

This Chapter describes also how to change colors and select
operating modes for your screen, and what are the available
mouse options.

If you are new to MS-DOS, study the MS-DOS® User’s Guide
for the basics of the operating system. For more detailed infor-
mation on, for instance, batch files, consult the MS-DOS®
User’s Reference Manual.
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The DOSSHELLBAT File

You can view the contents of the DOSSHELL.BAT file from
the MS-DOS command prompt by typing:

C:\>type dosshell.bat <ENTER>.

Your DOSSHELL.BAT file looks similar to the following
display, depending on the choices you made when installing
MS-DOS Shell:

@SHELLB DOSSHELL

@IF ERRORLEVEL 255 GOTO END

@SHELLC /TRAN/COLOR/DOS/MENU/MUL/SND/MEU: SHELL. MED

/CLR: SHELL. CLR/PROMPT/MAINT/EXIT/SWAP/DATE

:END

@BREAK=ON

The text in the line that begins with SHELLC contains the
options MS-DOS Shell uses as you work with it. You can
change or eliminate any option at any time.

Make a backup copy of your DOSSHELL.BAT file
before you make any changes.
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The options and their effect on the way MS-DOS Shell works
are the following:

/CLR:SHELL.CLR

This option tells MS-DOS Shell to look in the
SHELL. CLR file to set up the colors for your
monitor.

/COLOR This option allows MS-DOS Shell to change the
colors on your screen when you choose the
Change Colors command.

/DATE This option displays the date and time in the
menu bar.

/DOS This option maintains the programs and groups
of MS-DOS Shell. If you remove this option
from the DOSSHELL.BAT file, you will not be
able to edit any programs or groups.

/EXIT This option lets you exit MS-DOS Shell
permanently. If you delete this option, you will
not be able to quit MS-DOS Shell.

/MAINT This option lets you maintain your programs and
groups. If you delete this option, you cannot edit
a program or group.

/MENU This option lets MS-DOS Shell create new
screens when you create a new group.

/MEU:SHELL.MEU

This option tells MS-DOS Shell to look in the
file SHELL.MEU for the list of programs that
make up the Main Group on the Start Programs
screen.
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/MUL This option lets MS-DOS keep directory
information in memory to provide you with
faster performance. If you delete this option,
MS-DOS must read the disk to provide you with
directory information.

/PROMPT This option lets you exit Shell temporarily and
return to the MS-DOS command prompt. If you
delete this option, the Command Prompt title on
the Start Programs screen will be inactive or
grayed.

ZSND This option lets you take advantage of the sound
function on your computer.

/SWAP This option lets MS-DOS swap directories to
diskette drive.

/TEXT This option makes MS-DOS Shell appear in text
mode. No graphical images such as drive file
icons will appear.

/TRAN This option clears MS-DOS Shell from memory
when you quit the program. If you prefer to have
Shell remain in memory after you quit the
program, edit the DOSSHELL.BAT file and
delete the /TRAN option.
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Changing Colors on the
Screen

Computer screens come in a variety of sizes, shapes, and colors.

Your screen displays information in either color or mono-
chrome. A monochrome screen shows only one color. Color
screens give you a spectrum of color options to choose from.

The Start Programs screen contains a command which lets you
adjust the colors of your monitor: the Change Colors command.

Using the Change Colors command, you can choose from four
preset screen color sets and, regardless of whether you are using
a color or monochrome monitor, your screen’s appearance
changes. If you do not have a graphics adapter installed, this
function is not available.

To select a new color scheme, follow these steps:

Choose the Change Colors command from the Start
Programs screen.

Your current color scheme appears on the screen.

Scroll through the screens to view your choices using the
direction keys.

Choose the ENTER area to select the desired color
scheme.

The Start Programs Screen reappears in the colors you have
selected.

□
HJ

□
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Displaying Shell in Text or
Graphics Mode

MS-DOS Shell can display screens in two ways: text and color.
The options for text and color are contained in the DOS-
SHELL.BAT file. MS-DOS Shell uses the highest resolution
available on your computer. You can, however, choose a lower
resolution for your color monitor.

You have the following options:

/TEXT MS-DOS Shell appears in text mode without
graphic symbols such as file and drive icons.

/CO1 MS-DOS Shell appears in 16-color,
high-resolution 640 x 320 graphics.

/CO2 MS-DOS Shell appears in 16-color,
high-resolution 640 x 480 graphics (VGA
mode). You must have special hardware to
support this option.

/CO3 MS-DOS Shell appears in 16-color,
high-resolution 640 x 480 graphics (VGA
mode). You must have special hardware to
support this option.

Refer to your hardware manual to determine whether or not
your computer works with any of these options.
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Using Mouse Options

A mouse makes woiking with MS-DOS Shell a great deal
easier. The mouse options are the following:

ZLF This option provides for left-handed use of the
mouse.

/MOS:PCMSDRV.MOS

This option lets you work with a Microsoft serial
mouse.

/MOS:PCMSPDRV.MOS

This option lets you work with a Microsoft
parallel mouse (bus mouse).

For the instructions on working with a mouse, refer to those
delivered with your mouse.

7-9





Appendix A:
Glossary





Glossary

Active screen

The screen that is selected; the screen to which
your next keystroke or command will apply.

Application program

A program used for a particular kind of work,
such as word processing.

AUTOEXEC.BAT

A special MS-DOS batch file that can be created
to perform a desired set of start-up procedures
carried out each time the system is started.

Back up

To make a copy of a file, directory, diskette, or
fixed disk for safekeeping. Making regular
backups is a vital measure not to be neglected.

Boot

Loading of MS-DOS to start or restart the
computer.

Button

A large, rectangular button symbol that appears
in a dialog box and carries out or cancels an
action when chosen. The ESC=CANCEL button
always cancels the command. The ENTER
button carries out the command. The F1=HELP
button lets you get help for the selected item.

Change Colors screen

A screen that you select to modify the colors
displayed on your monitor.
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Choose

To perform an action that carries out a command
in a menu or dialog box. To make a choice
among actions listed in a menu or dialog box.
You choose by pressing a key or clicking a
mouse. See also Select.

Click

To press and release a mouse button quickly.
When you click a mouse button, you may hear
and feel a faint click.

Command

A program that tells MS-DOS how to do a
specific task. In MS-DOS Shell, commands are
found in a menu. See also Menu.

Command prompt

The MS-DOS command prompt appears on the
screen as the default drive letter followed by a
greater-than ( > ) sign. The command prompt lets
you know MS-DOS is ready to receive a
command.

Cursor

See Selection cursor.
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Default

Describes an option, command, or device that is
automatically selected or chosen by the system.
For example, in most dialog boxes that contain
key definition areas, one of the areas is selected
when the dialog box appears, indicating that it is
the default and will be chosen automatically if
you press the <ENTER> key. You can override a
default by selecting the appropriate option,
command, or device.

Dialog box

A rectangular box that appears when MS-DOS
Shell is providing you with information or when
MS-DOS Shell needs further information before
it can carry out a command. For instance, if you
choose the DELETE command from the File
menu, a dialog box appears asking for the name
of the file that you want to delete.

Directory

Part of a structure for organizing your files into
convenient groups. A directory is like a file
drawer that holds a particular group of files. A
directory can contain both files and
subdirectories.

Directory identifier

Displays your active drive and directory on the
File System screen.
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Directory tree

A list of directories found on the File System
screen. The directory tree looks like an
organizational chart, and it shows how your
directories and subdirectories are related within
the tree structure.

Diskette drive

A piece of hardware attached to the computer.
Diskette drives are used for reading information
from and writing information to diskettes.

Disk operating system

A group of programs that act as a translator
between you and your computer. MS-DOS is  a
disk operating system. See also Operating
system.

Diskette

A mass storage device used for storing programs
and files. In this documentation, the term
diskette includes 3.5-inch as well as 5.25-inch
diskettes.

DOSSHELL.BAT file

A batch file that contains the commands to make
MS-DOS Shell actions possible.

DOS Utilities screen

The DOS Utilities screen contains a group of
related MS-DOS commands.
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Double-click

To rapidly press and release a mouse button
twice without moving the mouse. This action
carries out a command.

Drag

To press and hold down the mouse button while
moving the mouse. For example, you can move
through a file list by dragging the shaft on the
scroll bar.

Drive identifier

The mark or icon in the upper-left comer of the
File System screen that represents your
computer’s diskette or fixed disk drive.

Drive name

Consists of a drive letter and a colon ( : ), for
instance C:. The drive name tells MS-DOS Shell
which drive to search for the file. For example,
the command type A:PROGRESS.RPT contains
a drive name (A:) that tells MS-DOS Shell to
look on the diskette in drive A for the file called
PROGRESS. RPT.

ENTER area

An area on the screen or dialog box. If you are
using a mouse, click this area to complete a
command. If you are using the keyboard, press
<ENTER>. See also Button.

ENTER key

The key you usually press after entering data or
text, or after you type an MS-DOS command.
On some computers, the <ENTER> key is called
the RETURN key.
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ESC=CANCEL area

An area on your screen or dialog box. If you are
using a mouse, click on this area to cancel a
command. If you are using the keyboard, press
<ESC> to cancel a command. See also Button.

Fl=HELParea

Displays an information box for any item you
have selected on the screen. Click the area with a
mouse or press <F1> to see help information.
See also Button.

F9=HEX\ASCII area

Press <F9> or click on this area with the mouse
to switch between ASCII or hexadecimal views
of a file.

F10=ACTIONS area

Press <F10> or click on this area with the mouse
to move to the menu bar.

File

A collection of related information. A file on a
fixed disk or diskette can be compared to a file
folder in a desk drawer. For example, a file
folder named FRIENDS might contain the
names and addresses of your friends. A file on a
disk could contain the same information, and
could also be named FRIENDS. Programs are
also stored in files.

File list

Displays the filenames of the active directory.
File lists are displayed on the File System screen.
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Filename

The name of a file. MS-DOS Shell uses
MS-DOS filenaming conventions: a filename
can be from one up to eight characters in length
and can have an extension of up to three
characters separated from the filename by a
period ( . ). An example of a complete filename
is PROGRESS.RPT. See also Filename
extension.

Filename extension

An addition to a filename. Extensions begin with
a period and contain from one to three
characters. The extension can be used to identify
files of certain format or type. Most application
programs supply their own extensions for files
they create. For example, all GW-BASIC files
use a filename extension of .BAS. See also
Filename.

File System screen

The File System screen contains most of the
functions you need to work with your files and
directories. You select the File System screen
from the Start Programs screen.

Fixed disk

A piece of hardware built into the computer.
A fixed disk can store much more information
than a diskette, and the computer can retrieve
information from it faster.
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FORMAT

An MS-DOS command that structures blank
diskettes or fixed disk partitions so that MS-DOS
can store data on them. You must format every
blank diskette before it can be used with
MS-DOS.

Grayed

Describes a command or option that is listed in a
menu or dialog box but cannot be chosen or
selected. The command or option appears in gray
type. For example, the COPY command on the
File menu of the File System screen will be
grayed unless you select a file to copy before
choosing the command.

Group

A group is a collection of related programs.
MS-DOS Shell has two groups when installed:
Main Group from the Start Programs screen, and
DOS Utilities. See also Start Programs screen;
DOS Utilities screen; Main Group.

Hard disk

See Fixed disk.

Hardware

The equipment that makes up a computer
system, not to be confused with the programs, or
software.

Help

Information about any item you have selected on
any MS-DOS Shell screen. Press <F1> or click
the F1=HELP area to display help information.
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Help index

Displays an index of all the help topics in the
help box. Press <F1 1> or <ALT-F1> to see the
help index.

Key definition line

An area on your screen or dialog box where you
can click with a mouse or press the appropriate
key to perform special tasks.

Main Group

The list of programs shown on the Start
Programs screen. See also Group.

Memory

Storage place for programs and commands.

Menu

A listing of available Shell commands. Menu
names appear in the menu bar near the top of the
screen. You use a command from a menu by
selecting the menu, then choosing the command.

Menu bar

The horizontal bar that lists the names of menus.
The menu bar appears below the title bar of a
window.

Operating system

A group of programs that translate your
commands to the computer, helping you perform
such tasks as creating files, running programs,
and printing documents. See also Disk
operating system.
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Path

The drive letter and directory name(s) specifying
where files reside.

Pathname

A description of the location of a directory or file
within the system. For example, the pathname of
a file consists of a drive letter, followed by a
directory name, one or more subdirectory names
if applicable, and a filename. Each name is
separated from the previous one by a backslash

PRINT

A command that activates your printer.

Program

A set of instructions, written in computer
language, that tells the computer how to perform
some task.

Prompt

A symbol that usually consists of a default drive
letter (usually A, B,  or C) and a greater-than ( > )
sign. The form of the prompt can be changed.
Different programs will use different prompts.

RENAME

A command that renames files and directories.

RETURN key

See ENTER key.

Root directory

The main directory MS-DOS creates on each
disk; the top directory in the directory tree.
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Run

To start an application.

Scroll

To move up or down within a box of information
on the screen to allow you to see the contents of
the box. See also Scroll bar.

Scroll bar

A bar that appears at the right side of the file list
and directory sections of the File System screen.
Help dialog boxes also contain scroll bars. See
also Scroll.

Select

To indicate the item that the next command you
choose will affect See also Choose.

Selection cursor

A means of emphasis used to indicate command
choices and selections. You move the selection
cursor around the screen with the direction keys
or the mouse.

SHIFT+F9=COMMAND PROMPT area

Press <SHIFT-F9> or click the area with a
mouse to temporarily leave MS-DOS Shell and
perform MS-DOS commands at the command
prompt.
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Start Programs screen

The first screen you see when you start MS-DOS
Shell. It contains the Main Group of programs.
You can add, change, and delete programs and
groups (up to 1 6) on the Start Programs Main
Group list

Text box

A box in a dialog box in which you type
information needed to carry out a command. The
text box may be blank when the dialog box
appears or may contain text if there is a default
option or if you have selected something
applicable to that command.

Title bar

The horizontal bar across the top of each screen
that contains the name of the screen.

Title list

A list of program and group names found on the
Main Group of your Start Programs screen, or on
any other group screen.

Wildcard character

A character that can be included in a filename to
indicate any character or group of characters that
might match that position in other filenames. The
wildcards are the asterisk ( * ) and the question
mark ( ? ). For example, *.EXE represents all
files in the directory that end with the .EXE
filename extension. The abbreviation *.* means
“all files in this directory.” Used in a command,
it causes the command to be performed to all
files in the current directory.
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